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Welcome to Eisenbahn.exe professional 

With Eisenbahn.exe professional ('EEP' for short), you can create complex railway worlds on your PC or notebook.
You can edit the terrain, shape mountains and valleys, populate layouts with structures and set up a sophisticated 
transport infrastructure. The different routes can then be loaded with rail and road vehicles, which can be controlled
using an elaborate signal system. Even air and maritime traffic is possible. The focus is, of course, on railway trains 
with steam, diesel and electric locomotive engines as well as passenger carriages and freight wagons, a wide range of
which are available. In addition to high-quality, faithfully reproduced rolling stock, EEP also offers great game depth with
endless construction and travel possibilities for layouts.

The complete model railway simulation for the PC was invented more than 18 years ago and has since enjoyed 
huge popularity thanks to its complex further development. Over the course of many years, the programme has 
been furnished bit by bit with detailed routes, a powerful signal system, freely editable timetables, an immense 
selection of vehicles, dynamic weather, automatic day/night cycles, animated characters and animals, and much more.
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What's new in EEP 13 ?

1. The programming has been further optimised to support more processor cores, resulting in EEP 13 running up to
20% faster and more efficiently than before. This has a direct effect on the framerate, especially in densely built-
up layouts.

2. The programme's registration routine has been changed and greatly simplified                             Chapter 1.2

3. The installation of models has been simplified                                                                                           Chapter 1.5

4. Adjustable transparency for control, overview and Lua windows                                                          Chapter 2.1

5. Camera orientation by clicking in the overview window                                                                         Chapter 3.1.1.2

6. Cross-layer editing of blocks and layer hiding at the touch of a button                                               Chapter 4.5

7. Random variation when placing landscape elements and structures                                                   Chapter 4.5.2

8. Sound effect for switch points can be switched off                                                                                    Chapter 4.6.1

9. Animated water effects and floating objects                                                                                               Chapter 4.6.7

10. New sky effects (vapour trails and rainbows)                                                                                              Chapter 4.9

11. Gamepad controls                                                                                                                                               Chapter 5.2.2

12. Gentle coupling                                                                                                                                                    Chapter 5.3

13. Improved vehicle physics for road vehicles                                                                                                   Chapter 5.5.1

14. Assignment of custom sound effects for starting, braking, coupling                                                    Chapter 5.5.4

15. Tooltips for objects and contacts                                                                                                                     Chapter 5.6.3

16. Track control panel (TCP) with extension                                                                                                      Chapter 7 

Furthermore, many user requests have been taken up and implemented as always. This all results in EEP 13 being
much more than just a continuous development of the software.

The entire EEP team hopes you have lots of fun building model railways!
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Licence agreement and warranty

The use of the train simulation EEP 13 is subject to the terms of the enclosed licence agreement which you must agree
to before you can install and use the software.

EEP 13 can only be used once the programme has been registered. The programme is activated upon registration 
and entry of the purchased personal serial number. Following the initial registration, the user is entitled to activate 
the programme up to five times per year on new, upgraded or additional computers. These personalised usage rights
apply not only to the main EEP 13 programme, but also to additionally purchased models as the personal customer 
number is also entered when these are purchased. This guarantees that these models only work on the computer 
that has been activated using the same EEP serial number and registration number.

All hardware and software names mentioned in this manual are registered trademarks and should be regarded as 
such. We have taken every care to publish complete and accurate information in this manual, the programme and 
other information sheets. TREND Redaktions- und Verlagsgesellschaft mbH Deutschland does not assume any warranty,
legal responsibility or liability for the use of this information. TREND cannot be held liable for any damage resulting 
from the malfunction of programmes, circuit layouts, etc., or for the infringement of patent or other rights of third 
parties resulting therefrom.

All rights reserved. No part of this work may be reproduced in any form (print, photocopy, microfilm or any other 
process) or edited, duplicated or distributed using electronic systems without the prior written consent of TREND 
Redaktions- und Verlagsgesellschaft mbH.

Commercial use of the software also requires the agreement of TREND Redaktions- und Verlagsgesellschaft mbH.

TREND Redaktions- und Verlagsgesellschaft mbH
Germany · Copyright © 2003
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Allgemeiner
Hinweis

Auf der Startseite und unter dem Menüpunkt „Hilfe“ finden Sie ein  umfangreiches
Video Tutorial, welches Ihnen den Einstieg in EEP erleichtert.
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1. Installing, launching and registering EEP 13

1.1 System requirements

For the installation of EEP 13, the following minimum 
system requirements must be fulfilled:

In terms of performance, the following 
configuration is recommended:

Good to know: 
EEP is being continually developed. The huge range of add-ons, plug-ins and models in the EEP online shop
is easier and faster to use if you have a fast DSL internet connection.

1.2 Installation (DVD version)

1.2.1 First-time installation (without a previous EEP installation)

After inserting the EEP DVD-ROM, launch the
programme 'autorun.exe' on the DVD. Click on
the 'Install' button in the autostart menu that
appears and follow the instructions.

If you receive security warnings while launch-
ing the autostart menu or during installation,
you can safely confirm the execution of the
programme. After completing the installation,
please start EEP 13. You can start the pro-

•  Windows 7 / 8 / 10
•  (32 Bit)
•  Dual-Core 2,5 GHz,
•  1 GB Grafik, Pixelshader 3.0,
•  4 GB RAM, DirectX 9,
•  Internetzugang

•  Windows 7 / 8 / 10
•  (32 oder 64 Bit)
•  Dual-Core 3,2 GHz,
•  2 GB Grafik, Pixelshader 4.0,
•  16 GB RAM,
•  DirectX 11, 5.1-Soundkarte,
•  Internetzugang
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gramme from the autostart menu on the DVD, for example. Now select 'Product registration over the internet'; 

EEP 13 will next ask if you already have a TREND EEP online
shop account.

If you do not have a TREND shop account yet, please
click on 'No' and then enter your details in the win-
dow that appears. Enter your serial number in the
field provided. Now click the 'Register' button. This
requires an internet connection. 

EEP will now contact our registration server, which
will activate your licence and assign you a registra-
tion number (R/N). 
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Now forward the registration number to the shop via the highlighted link and please write this number down; you will
require it if you wish to install additional content with your EEP 13 licence.
Installation and registration are now complete. The EEP 13 start screen will appear. Here you can start the demo
layout, watch the video tutorial, visit the EEP shop or start your own layout. 

1.2.2 Installation with pre-existing version of EEP, from EEP 7 onwards

If you already have a previous version installed on your computer, from EEP 7 onwards, and have registered in the
shop, you already have a registration number (R/N).  This number is used to authorise all programmes and models pur-
chased in the shop and should be maintained across all versions of EEP. In this case, please proceed as follows so that EEP
can check and transfer the registration number in your shop account. This will ensure that you can continue using all the
models you previously purchased in EEP 13. 

Please answer 'Yes' to the question in the following
dialogue window.

Please enter the required information in the window
that appears. Another window will now appear with
all of your details already filled in. Please enter your
EEP 13 serial number here and click on 'Register'.
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The following window will then appear. 

Please click on 'Import' and then enjoy
the new features of EEP 13.

1.3 Advantage of registering

Why register? The registration process may seem tedious and inconvenient at first glance, but it will soon prove advan-
tageous and helpful as it guarantees that your usage rights are not limited to one computer and are not confined to the
one-time registration. By registering, EEP 13 is initially only activated for the computer on which the programme was
first installed. But this does not stop you from using the programme on another computer – for example, a laptop. The
advantage of registering: as a licensee, you can make use of up to five activations per year on one or multiple computer
with just one serial number. This allows you to

•  install and activate EEP 13 multiple times on the same computer,
•  use EEP 13 on multiple computers simultaneously,
•  use additional models and add-ons you have purchased on multiple computers,

without having to purchase it again for each device.

Generally, EEP 13 needs to be activated each time it is installed. If you request a reactivation of a programme you have
already registered, the computer on which the programme has been reinstalled will be checked. If this is the same com-
puter as during the initial installation, the current hardware setup will be compared with the setup as it was during the
first installation. If no hardware changes are detected, EEP 13 will be reactivated, but this activation will not be considered
a new registration. This ensures that the programme can be installed, uninstalled, reinstalled and activated on the same
computer (for whatever reason) as many times as you like, without affecting your right to up to five registrations per
year.

This is different if the previously registered programme is being activated on a new or modified computer. If the check
determines that the computer is a new one or that the hardware setup does not match the setup during the initial reg-
istration – due to the installation of a new graphics card or additional memory, for instance – the programme can be
reactivated until the maximum number of five registrations per year has been reached.

These usage rights, which become effective with your first registration, are not just limited to the main EEP 13 pro-
gramme, but also apply automatically to additionally purchased models and add-ons for EEP 13 which, like the
programme, are also registered to you personally using your customer number.
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1.4. Uninstallation

Please left-click on Start, Control Panel and then on the 'Add or Remove Programs' icon (or if using Windows
Vista/7/8/10, click on Start, Control Panel and 'Programs and Features'). 
Now select the entry for the game by clicking on it in the list displayed. Then click on the button 'Change/ Remove' (or
if using Windows Vista, click on 'Uninstall') and then follow the uninstallation instructions.

If using Windows 8, please switch to desktop mode, go to Settings, Control Panel, Uninstall programmes, then select
EEP 13 and confirm uninstallation by clicking 'Uninstall'.

1.5. Installing new models

As the option to install new models has been overhauled, we have provided a separate point for it here. New
models, whether these are models purchased in the TREND EEP online shop or free models from a designer’s own 

website, can be integrated into the programme as
follows:

Start EEP 13

Click on the 'New layout' button
In the planning window in the 2D view, click on
the 'File' menu and then on the option 'Install
models'.

Select the folder where the models you wish to
install are stored.

Click on 'Install'.
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Following successful installation, you will receive the fol-
lowing message.

You will find your model in the 'newly installed models' folder.

You can take it directly from here and insert it into the layout currently open. Thus, unlike in earlier versions of EEP, the
scanning of all models before the initial insertion of a new model is no longer required. Scanning is, however, still nec-
essary for models installed in EEP to be sorted into and shown in the correct categories. 

2. Screen layout

After successfully installing
and registering EEP 13,
upon launching the pro-
gramme you always arrive at
the start screen, which
should offer you all available
options. Choose whether you
would like to start with a
new layout, load your last
edited layout or open a
saved layout. You can also
start the video tutorial.
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2.1 The planning window of the 2D view and the 3D window

The 2D window (planning window) shows you the layout in a two-dimensional drawing view. This is the view in which
you will mainly be planning and constructing your layouts. In the 2D view, you will lay tracks, roads and waterways and
also insert most landscape elements, structures, signals and contacts. You can also edit and shape the terrain properties
and landscape relief in the 2D view.

The vertical tab bar is particularly prominent, separating the plan from the so-called tool dialogue on the left. The
 individual buttons activate the respective editing options. They are only presented here briefly. A special introduction 
to the use of the individual tool dialogues follows later. The display of the layout in the plan changes, depending on the
option selected.

 Layout description, full view of the layout in the plan

 Editor for building the rail network for railway traffic

 Editor for inserting track-related elements such as stations and bridges

 Editor for building the road network
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 Editor for inserting road bridges, etc.

 Editor for building the tram network

 Editor for inserting tram-related elements

 Insert animated characters and animals

 Structures editor

 Insert landscape elements

 Surface design editor

 Create a signal system

 Insert loadable goods

 Create water and air route, camera rails, telegraph lines, etc.

 Insert water and air route-related objects

 Editor for control tracks and pre-set routes

The results of your construction can be viewed in the 3D window, which can be accessed via the button in the bottom
left. In this mode, you can view and explore your layout and control the traffic manually. Here you can follow the rail
transport operations from different adjustable camera angles.
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Additionally, there's also a 3D object editor available which you can use to insert and edit landscape elements, struc-
tures, tracks, rolling stock and signals directly in the 3D view. There are two additional programme elements 
docked beneath the 3D view window: on the left you see the control dialogue – a control panel with which you can
control all rolling stock as well as set the function and angle of the camera. To the right of that, you'll find the 
overview window, which shows the currently selected section of the layout plan and simplifies the 
controls and the orientation in complex layouts. Here you can set the rolling stock on their tracks (re-track). 
You can manually control signals and switches not only in the 3D window itself, but also in the overview window.

Good to know: 
The control dialogue and overview window are docked beneath the 3D view by default, but can be undocked,
scaled and moved freely. This can be very helpful if you are working with two screens: on one monitor you
are observing the rail operations in 3D view, while on the other you are controlling the rolling stock, switches
and signals. The 'Undock windows' option can be activated in the programme settings dialogue, which
you can open using the corresponding menu option or by clicking on the button in the tools. When this option
is active, you can move the control dialogue and overview window wherever you like, or even make the
overview window and control dialogue transparent. You can do this by clicking on the top-left corner of the
window and selecting the level of transparency from the context menu. The same applies to the EEP event
window in which both system messages and texts created by the Lua script can be displayed (cf. Chapter 6.5
and the Lua manual in the help feature of EEP). 

2.2 The function bars

EEP 13 is controlled using menu commands, buttons on control bars and tool bars, and keyboard commands – 
so-called hotkeys – both in the 2D and 3D views. Features that are only available in the 2D or 3D window are automati-
cally locked in the other view. While the menu always remains visible, the tool bar, control bar and status bar can be
 hidden.
Most programme features can be activated via both the menu and the tool bar. There are, however, some features that
can only be accessed via the menu or via the tool bar.
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2.2.1 The menu

File menu: Via the File menu, you can create new layouts; open saved layouts,
blocks and train consists; save open layouts, blocks or train consists; adjust the pro-
gramme settings; view layout information; scan recently added models and exit the
programme.

ATTENTION: If you save your layout using the 'Save as' feature, you will be asked which object classes
should be saved. If you limit saving to individual object classes, it is recommended that you save under a
different name. Saving under different names or with sequential numbers is always advisable and – depend-
ing on your construction progress – should be done every 10-15 minutes. Layouts that come with EEP, but
which have been modified with your ideas, should always be saved under a new name as this is the only
way of preserving the original layout! 

Insert menu: With the commands in the Insert menu, you can undo and
redo the latest steps; select, copy and paste a block; adapt the placed models
to the height of the surface or delete them; show the dialogue window with
the object configuration of a selected model.

View menu: You can determine what is shown on the screen via the View menu: depending on the situation and 
your requirements, you can display the 2D planning window, the 3D window, the maximised window and the
3D full screen; zoom in, zoom out, centre and automatically scroll the view. You also have the option to show or
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hide the construction grid, objects in various categories, the tool bar, the control bar and the
status bar, if required. The settings you choose in the View menu are saved automatically 
so the programme window will look the same as when you left it the next time you launch
the programme.

The menu options View 2D window and View 3D window allow you to choose which
 elements are and are not displayed in the planning window and 3D window – and even indi-
vidually for each editing mode in the planning window. So, you could hide the landscape
elements, for example, when you're working in the signal system.

A black checkmark in a button shows you that the layer is currently visible. As an alternative
to making this selection in the menu, you can also right-click on the button for each layer to
make it visible or invisible.

Attention:
The settings for the signal editor in the planning window are also used to determine what is visible in the
overview window.
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All elements in the scene are visible. Now you can adapt this view. Switch to the planning window and select the signal
editor. Then right-click to hide the structures and landscape elements.

Switch to the planning window and select the signal editor. Then right-click to hide the structures and landscape ele-
ments.

You can now configure the view in the overview window to suit your needs.

The display of the different object categories in the 3D window can
only be changed via the 'View' menu and the 'View 3D window'
menu option. Here you will find the option to hide the special 3D
models for pre-set route signals, among other things. 
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Edit menu:
This menu offers a range of special tools for layout construction in 2D. Here you
can load track combinations, calculate track connections or scatter landscape
 elements in a selected area, for example.

Camera menu:
The Camera menu allows you to select a saved static or dynamic camera, set the
perspective, set and save new camera positions, and zoom in and out of the 3D
view. Additionally, you will also find the 'Motion inertia' and 'Activate camera
contacts' options (only in this menu), which create a flowing camera motion and
an automatic camera change during automatic rail operations.

Routes menu:
The Routes menu is responsible for the automation of rail operations. You can 
create a list of route names here which are used as filters in automatic operation or
compose entire timetables.

Extras menu:
In the Extras menu, you can search for a signal/switch (with known ID) within the
layout, change the layout size, change the grid and spline settings, set the EEP time
properties for automatic rail operations, and extract resources from the package file.
You will also find the Properties Explorer (see Chapter 5.2.4), the Lua Wizard 
(see Chapter 6.5.1) and the Control Panel Editor (see Chapter 7) here.
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Help menu:
The Help menu provides access to the manual (PDF), the 'Deutsche Bahn' (DB) sig-
nal book (in German), the Lua manual and the video tutorial. You will also find our
technical support here.

Community menu:
In the Community menu you will find, among other things, a link to the EEP forum
(www.eepforum.de) where countless EEP users discuss topics relating to the pro-
gramme each day. 

Shop menu:
From the EEP Shop menu, you can access the EEP shop, which offers a large number
of additional models and finished layouts.

2.2.2 The tool bar

Most of EEP's features can be activated quickly and easily via the tool bar. By clicking the following buttons, you can
quickly access the following core functions.

1 Start a new layout

2 Open a saved layout

3 Save the open layout in its current state (this replaces the previous version)

4 Save the layout under a different name

5 Open a saved block

6 Save the open block
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7 Select a block

     
8  Copy the selected block to the clipboard

    
9 Insert the copied block

  
10 Undo/Redo

      
11 Bring camera closer

      
12 Pull camera back

      
13 Centre planning window (2D view) or overview window (3D view) on the current camera position

      
14 Align camera to the rolling stock active in the control dialogue

      
15 Set up camera in the planning or overview window

      
16 Save current camera position

17 Activate saved static or dynamic camera positions
      

18 Configure environment settings
      

19 Adjust the programme settings
      

20 Lua script language

2.2.3 The control bars 

While the top tool bars of the 2D and 3D views are identical, the bottom tool bars (bottom left) are different as they 
are geared towards each view. Only the zoom buttons are identical but they relate to the 2D plan on one hand and 
the overview window in 3D mode on the other. In the planning window, this bar is predominantly used when precision
is required.

The bottom tool bar in 2D view: 

          
1 Switch to 3D view

          
2 Use the spline function (for positioning masts, lanterns, etc. on tracks or roads)

          
3 Show or hide the grid display

          
4 Show or hide the protractor

          
5 If landscape relief is turned on: show ground texture; 

              if landscape relief is turned off: toggle background colour between black and grey
    

6 Zoom in or out of the 2D window
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The bottom tool bar in 3D view:

                                     
 
1 Switch to 2D view

                                     
 
2  Switch the lighting on or off in active rolling stock

                                     
 
3  Grab and load goods such as containers, crates, etc. with special cranes

  
4 Selection box for moveable axes, such as doors, tailgates, crane jibs, etc. 

(if available on the selected model)

                       5  Control moving parts on rolling stock

                6  Time-lapse function (fast run-through of pre-set sequences)

                                         7  Selection of editable objects

                                8  Zoom in or out of the 3D window

2.3 The gizmo (manipulator)

Using the gizmo will greatly simplify the construction of your layouts. You can already identify most of the features in
the following picture.
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You can 'grab' the gizmo's coloured elements with the left mouse button and realign your model. The gizmo's three
arrows are for the precise positioning of a model along an axis.  Models can be rotated using the rings. And the beads (in
the middle of each arrow) are used to scale each axis. If you would like to enlarge or shrink a model as a whole, please
use the blue bead while holding down the [Ctrl] key.

Attention:
You can temporarily deactivate the gizmo by holding down the [Shift] key

Tracks have two gizmos – one complete at the start of the track, and one without rings at the end. 

2.4 Navigating with the mouse in the 2D window

There are several options for navigating in the 2D window. Firstly, you can scroll the section of the screen using the familiar
scrollbars (at the bottom and right). 

The second option is to move the section of the screen directly by clicking and holding the right mouse button. 

Thirdly, you can use the mouse wheel. If the mouse pointer is located at the edge of the planning window, you will move
the map section. If it is in the middle of the map, you will zoom in or out of the display. The point under the mouse pointer
will remain in place.
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3. Camera management

3.1 Operation and controls
Handling the camera is a fundamental part of model train building with EEP. You will see whatever appears in 3D view
from the angle of the camera that you control using the mouse and/or keyboard. Depending on the camera mode, you
can move the camera freely and explore the layout under your own steam, or couple the camera to a train and enjoy the
railway landscape from the perspective of a passenger or the driver.

3.1.1 Positioning and aligning cameras
Generally, you can position a camera in any area of the layout and move it in all directions. The angle, which is marked
by green lines, can be adjusted in both the 2D view and the overview window of the 3D view. The thinner vertical line
shows the height and the other, slightly thicker, line shows the direction and distance the layout or object is being viewed
from. Additionally, the focal width of the camera is shown by two dashed lines.

3.1.1.1 Positioning and aligning cameras in the 2D view
To set the position and angle of the camera, click on the Set camera button in the tool bar. Once the function is
active, a small camera will appear on the mouse pointer. That's the signal that the camera can be placed:

•  Click – without releasing the mouse button – on the point where the camera should be placed,
•  Hold down the left mouse button and drag the pointer in the direction you want to look,
•  Release the mouse button to fix the camera angle. EEP will instantly switch to 3D view.

As you will note, the vertical line will remain constant, while the direction and length of the second line will 
change: if the line is short, you are looking in the immediate vicinity; if the line is long, you are looking into the
distance.

By default, the camera is placed approx. 5 m above
the layout surface, irrespective of the actual
height of the terrain. However, you can also view
the layout from a higher or lower position:

• Click on the Set camera button and position the
mouse pointer over the desire camera 
location.

• Now hold the [Ctrl] key and the left mouse but-
ton and move the mouse up and down to
change the height of the camera position.
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• Now release the [Ctrl] key and drag the mouse to set the desired camera angle while still holding down the
left mouse button.

• Now release the mouse button too to set the camera and to switch to the 3D mode.

3.1.1.2 Positioning and aligning cameras in the overview window of the 3D view

You can also set the camera in the overview window in the same way as described in the previous section for the
planning window. You will find the button for setting the camera in the tool bar at the top.

Alternatively, you can simply hold down the [Ctrl] key and right-click a point in the overview window. The camera
will then be set beneath this point, facing due north. And if you hold the [Shift] key instead, the camera will
remain in its position and aim in the direction you clicked. 

3.1.2 Saving the camera position

Particularly interesting camera angles deserve to be kept. By clicking this button, you can save your cur-
rent camera position.  Once this function is activated, a dialogue window will appear where you can enter

the name you want to save the camera position under.

Each layout has storage spaces for 80 static and 80 dynamic camera positions. To view saved positions, please
open the list on the right next to this button.

Good to know: The static camera remains fixed without the camera angle changing. The dynamic
camera, on the other hand, follows the rolling stock selected in the control dialogue from its posi-
tion.

3.1.3 The mobile camera

In addition to the static and dynamic cameras a mobile camera is also available in EEP 13. Mobile – what does
that mean? While the static camera is bound to a location and the dynamic camera to rolling stock, the mobile
camera goes its own way. Literally! You can give this camera its own path.

• Click on the 3D object editor button in the control dialogue in the two-part window view to switch on the 3D
editor mode.

• Before a mobile camera can take action, you need to set the route the camera will take.
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To do this, click:
–  the Tracks (splines) model category in the right column of the selection dialogue,
–  then the Auxiliary splines category and the 'Camera and dolly track' option
–  and then the type System track for the mobile camera in the model selection.

After making this selection, go to the 3D window to determine the path of the mobile camera section by section using
the mouse. This special system track is only visible in editing mode.

Good to know: 
The mobile camera track is laid and edited in exactly the same way as any other track. How this is done is
described in detail in the example of the track editor in Chapter 4, section 4.6.1.

If you would like to go back and make changes to a system track for the mobile camera, first select the respective section
of the track as usual by left-clicking it, and right-click to open the object menu. In addition to various editing 
options, such as Move, Rotate, Add track and Delete, you will also find the Object properties dialogue window here
allowing you to set the start position and path precisely. The track can also be extended directly by double-clicking 
on the green end point. You can place a camera on the dolly track by selecting the camera from the object menu
and clicking the desired location on the track.

Once a mobile camera has been placed on the track, a camera icon will appear there. Right-clicking on this camera 
will take you to Object properties. With 'Test camera settings' in the top-right, you can set up the camera. 

Auswählen des Systemfahrweges der mobilen Kamera
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Click on an object while
doing this and the camera
will remain focused on
this object throughout its
journey. 

Please enter the speed in
the left table.

And slightly below that
you can enter a name for
the camera.

The static camera is fixed to motionless elements. The dynamic camera, on the other hand, follows the selected 
rolling stock. The gyroscope keeps the camera balanced on inclined corners. 'Display information text' allows you to
enter a text that is shown during the camera's journey.

Das Zielobjekt wird durch einen grünen Pfeil markiert

EEP bietet für Kameras vielfältige Einstellmöglichkeiten
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If you switch on the depth of field option, the virtual EEP camera will take on the properties of a real SLR camera 
to some extent. This means that the aperture and exposure affect the distance over which the camera image remains in
sharp focus. At a small depth of field, the camera must be focused precisely on the target object. At the bottom of the
menu, you will find a list box of transition effects for changing from this camera to the next.

3.2 Camera management in the 3D window

Clicking on the camera icon in the control dialo-
gue of the 3D window opens the camera menu
(not to be confused with the Camera menu in the
menu bar!) which displays something like a con-
trol centre for camera controls.

Unterschiedliche Optionen für die Kameraführung
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1 Free camera movement to navigate the layout without restrictions
2 Linked camera, if you want to link the camera to the active rolling stock
3 Tracking mode to follow the train with dynamic cameras
4 Timer camera to pass rolling stock from camera to camera once it is in motion

3.2.1 The free camera
In the free camera mode, you can navigate the 3D view freely and without restrictions – using the mouse and 
keyboard:

Mouse:
Position the mouse in the centre of the 3D view. If you hold down the right mouse button, you can move forward by pus-
hing the mouse up. Travel backwards by moving the mouse down. And for corners, steer the camera left or right at the
same time. The closer you move the mouse to the edge of the screen, the faster you will move. By holding down the scroll
wheel, you can circle the point under the mouse pointer. With the mouse pointer on the edge of the screen, you can pivot
the camera by turning the scroll wheel. And if the mouse pointer is in the centre of the screen, you can zoom using the
scroll wheel. It will target the position of the mouse pointer.

Keyboard:
In addition to the mouse controls, you can adjust the camera in 3D view using the keyboard:

• Use the arrow keys to pivot the camera up, down, left and right.
• Use the arrow keys while holding the [Ctrl] key to move the camera.
• Hold the [Shift] key to circle the camera around the centre of the picture.
• Press the [Page Up] and [Page Down] keys to raise or lower the camera.
• Press the space bar to move the camera forwards in the 3D view.
• Press the [R] key to move the camera backwards.

3.2.2 The linked camera

This mode links the camera to the rolling stock
selected in the control dialogue. During the jour-
ney, the camera will remain in the same, relative
position to the vehicle. First, choose a starting
position using the buttons in the control dialogue,
and then use the mouse or keyboard to make pre-
cision adjustments.

Diese Kamera bleibt in unterschiedlichen Perspektiven
beim ausgewählten Rollmaterial
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Alternatively, you can also access the starting position using the numbers 1 to 0 on the alphabetic keyboard.  The numbers
1 to 6 correspond to the 6 buttons in the control dialogue. You can circle the vehicle using the arrow keys or by holding
the right mouse button. You can adjust the distance to the vehicle using the space bar and [R] key or the scroll wheel.
Number 7 automatically activates the dynamic camera that is closest to the selected vehicle. If the vehicle is in motion,
EEP will automatically switch to the closest dynamic camera. The number 8 and 0 switch to the cabin views. The two
views may differ in some locomotives. The driver for instance may be visible in one, but not in the other. Leave the 
cabin view by pressing the [F9] key. The camera will then stay in its current position. By pressing the button again, you
will re-activate the on-board camera.

3.2.3 Tracking mode
The dynamic cameras are always pointing at the currently selected rolling stock from their fixed positions. If the vehicle
moves, the camera will follow it. Place several cameras in attractive locations and you will always have a good view of
your train ([7] key).

3.2.4 The timer camera
The timer camera ensures that the view jumps to the following camera at
the set interval. Its alignment always remains the same.   

3.2.5 Activate camera contacts
Each saved camera (static, dynamic or mobile) can be accessed via a contact.  The 'Activate camera contacts' must be
switched on in the 'Cameras' menu. The keyboard shortcut for this option is [F10].

Wählen Sie das Fahrzeug aus, dem Sie 
folgen wollen

Die Zeitangabe entscheidet nach welcher Periode das Bild umgeschaltet wird.
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How does it work?
Suppose you have an oval of track that a train will travel along. Set contacts at the highlighted positions where the camera
should change to automate the camera management during automatic operation. When the train drives over a contact,
the camera moves to the predetermined camera location and shows the scenario from the point of view of the saved
camera.

How are contacts set in 2D view?

• Activate the signal system editor in the 2D view.
• Select the camera contact type in the signal editor selection menu and then click on the button with the 

signal arm.
• Now move the mouse cursor to the section of track in the layout plan that you want to assign the 

contact to.
• Click on a track where the camera should be activated when the train touches the contact.

Good to know:
You can work more easily, faster and more intuitively in the 3D editor mode: select the desired track location
with the left mouse button, right-click to open the context menu, select the contact for the camera and
set its position by left-clicking the track again.

The green icon (show in 3D in the 3D mode) that now appears shows that the camera contact has been placed. The two
triangles represent the direction in which a train must pass the contact and thus trigger the camera change. You can
move the contact along the track by use of the red and yellow arrow from the gizmo. To assign a saved camera to a contact

Auswahlbox für die Kontaktpunktreferenz

Darstellung eines Kontaktpunkts für Kameras im Einsetzmodus
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and to define the required settings, right-click the selected contact. In the following dialogue, you can configure the
camera contact by defining the train passing, route, vehicle, contact trigger conditions and camera control.

Camera contacts are configured using the following parameters:

– Direction: Here you set the direction from which the train must come to trigger the contact.
– End of train: If you select this option, the contact will only be triggered once the entire train has passed by.

– Every: Enter a 2 here instead of a 1 and the contact will trigger the camera change with every second train 
that passes.

– Counter: This field shows the current status of the 'Every' counter. If the value is 1 lower than the 'Every' value, the
next train will trigger the contact.

– Delay operation: Determine the number of seconds after which the contact is triggered.

– For route: Here you can choose if the contact is only triggered by vehicles assigned to a specific route.

– Vehicle contact: Here you can decide if the contact is only triggered by a specific vehicle.

– Filter name: If you have selected the 'All' option in the vehicle field, you can determine that only vehicles whose
names begin with the text you have entered trigger the contact.

– If signal/turnout: You can use this option to link the triggering of a contact to a specific signal or switch point. If
the position is different at the moment the contact is triggered, the contact is ignored.

– Select camera: Here you select the first camera that should be activated when the train passes over the 
contact.

– Follow-up camera: Here you select which camera to switch to following the duration of the time set in 
the field.

– Perspectives: If you haven't selected a 
camera for 'Select camera' and 'Follow-up 
camera', you can instead select the 
perspectives to switch to the linked,
i.e. passenger views.

– Do not interrupt: If this option is activated,
no other camera can be switched to by con-
tacts until the time expires.

Einstellungsoptionen für Kamera-Kontaktpunkte
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4. Building and designing layouts

4.1 Exploring and getting to know EEP

Perhaps you would like to get an idea of what finished, automated layout can look like before constructing your first lay-
out? Then open one of the layouts included. Following installation, you will find the 'Demo' button in the launch menu.
This loads a layout of the same name from the layouts folder. A fully automated version of the layout 'In Vino Veritas'
with many camera journeys. EEP automatically switches to full screen mode when this layout is loaded. Sit back and
enjoy the varied rail traffic to the left and right of a large river bend. 
Once you have saved the first layout of your own, the 'Demo' button will disappear and be replaced by the 'Previous
layout' button. It can still be found in the layouts folder, however. If you would like to leave the full screen mode of this
scenario, please press the [Esc] key. 
In the layouts folder, you will find other layouts that will give you an idea of what EEP has to offer. Please read the layout
description that opens after loading. It contains important information about operations.
You can turn off the automatic camera change during layout operations at any time. This is done either in the 'Cameras'
menu or using the [F10] key. Then you have the chance to move freely across the layout or to access the various cameras

Maximiertes Fenster mit zugeschalteter Menüleiste
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you have saved from the menu. This does not interrupt current operations. Enable the option again to leave camera con-
trol to the contacts. The biggest attraction of EEP is, of course, building your own layouts. And we will now familiarise
you with that.

4.2 Setting up a new layout

Building a new layout starts with the File menu command 'New'. When you execute this command, a dialogue window
appears in which you must first set the length and width of the layout as well as the density of the grid in knots. The
higher the grid density, the more precisely mountains can be formed and textures sprayed, but also the higher the
demand on your system and computing performance. With limited processing capacity in mind, the grid density should
not be set too high. 150 grid nodes are recommended for your first attempts. Based on this guideline, you can test your
computer's reactions and computing speed.

Attention: The grid density is dependent on the size of the layout and can therefore only be set relative
to its width and length. The minimum and maximum values you can choose are indicated. The highest value
is 800,000 grid nodes. As a calculation example, let's suppose we have a 5 x 1 km layout with the recom-
mended number of 150 grid nodes:

5 km x 150 grid nodes           =      750 grid nodes in length
1 km x 150 grid nodes           =      150 grid nodes in width
750 x 150 grid nodes             =      112,500 grid nodes across the surface

This size is far enough beneath the permitted limit to ensure good performance on most computers. Your layout will
look far more interesting if you lay tracks not only on flat surfaces, but follow the contours of a fully formed and textured
surface. You can change this landscape at any time, adapting it to your new requirements. 

You can provide the surface with a texture motif from the start. These
motifs are combinations of four textures that are applied to surface
depending on the angle of inclination and provide a good foundation for
later texturing. Furthermore, you can start with a randomly formed land-
scape. It is recommended to use a high value for the 'Percentage of
elevations' and a low one for the 'Maximum height'. This initial form is
not binding and can be changed as desired. 

Im Anlagendialog werden die Grundeinstellungen zu Anlagengröße,
Bodenbeschaffenheit und Rasterpunktdichte vorgenommen
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4.3 Modelling the landscape
There are two editors available for editing the landscape – the 2D surface editor and the 3D terrain editor. Each editor
has different benefits and both complement each other well.

4.3.1 Relief and surface design with the 2D editor
With the surface editor, you can design your railway landscape in 2D view. Therefore, you work in the drawing mode and
switch to 3D view after each step to check the results. The editor appears when you open the editors list in 2D view and

select the 'Surface design' option. Once
the surface editor is open, the palette of
relief and surface design tools will be
shown in the left of the 2D window.

Automatisch erzeugte Landschaft im 3D-Editor

Zur Gestaltung der Oberfläche stehen 
Werkzeuge zur Verfügungen, mit denen
man Erhebungen erzeugen und die 
Landschaft texturieren kann.
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With these surface editor tools, you can edit the surface of the EEP landscape.

 Draw and model mountains

 Draw and build slopes

 Set up and define local weather zones

 Set parameters for height, edge smoothing, and slope width

 Activate spray gun for texturing at the desired intensity

Modelling mountains and slopes:
Learning to handle the surface editor tools requires practice. To get to know the required techniques, start by building
a simple mountain:

• Switch on the surface editor set the Height and Smoothing. The Height parameter measures the height above or
depth below sea level – depending on whether the value entered is positive or negative. Smoothing refers to the
edges, i.e. the gradations of the height profile. The higher the number (a value between 1 and 100), the further the
mountain's foothills run (to a sufficient extent).

• Once you have set the parameters, click on the button that activates the mountain drawing tool. You are now in
drawing mode.

• Now move the mouse to the drawing areas and draw a close contour while holding down the left mouse button.
Release the mouse button when the contour is closed.

• Now draw a second contour that completely encloses the first one: the first determines the surface and height of the
mountain plateau, while the second one determines the size of the foot of the elevation. The closer  together the con-
tours are, the steeper the mountainside will be.

• Repeat this process a few more times until you are familiar with the procedure, and then switch to the 3D view to ad-
mire your work in full 3D.

The results in the 3D window probably won't knock your socks off just yet – the plateaus will look too bizarre and harsh
with their sharp edges. But that can all be changed with a bit of patience and flair. Through interpolation, i.e. repeated
drawing of the mountains and valleys with the same height parameters and similar co-ordinates, you can smooth the
edges and generate a more realistic landscape with soft contours.
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You can see exactly how this is done from the example in the figure: draw the plateau of a second mountain next
to the first one. And then draw the foot of the second mountain large enough so that it encloses the first mountain. 

The set Smoothing value now also affects the existing mountain. Its peak becomes round and the hillside flatter.

The second tool available for relief design in the surface editor activates the slope feature. Slopes are built to connect
levels of different heights. In a model railway layout, you often cannot get around building railway embankments, and
this is where the slope tool comes in useful. 

The construction principle is similar to that of designing mountains 
and valleys, only this time you don't have to set the Height and 
Smoothing parameters, but rather Slope width. The height values are

determined by the start and end points of the slope and are used as base values for the course of the slope.

Once you have set the width of the slope, it is time to draw:

• Click on the ruler in the control bar to show the crosshairs – this ensures precision and facilitates drawing, but is not
absolutely necessary for terrain design.

• Then activate the slope tool, point the mouse cursor at the point on the layout plan where the slope should start, click
and hold the left mouse button, and then drag a connecting line to the point where the slope should end.

Gestaltung von
Bergen und Tälern in EEP

Glättung von Höhenunterschieden im Gelände
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• Release the mouse button to review the finished slope in the 3D window. Slopes can also take a sweeping course. If,
for example, you would like to model a landscape with a river snaking through the hollow of the valley between the
hills, you can also realise this with the slope function, only this time you will connect the different levels with 
curved lines.

Designing surfaces
Whether it's a mountain, valley or slope, while the surfaces are bare – without meadows or forests, fields or rocks cov-
ering the ground – the landscape will appear unreal and abstract. To generate a realistic appearance, the bare surfaces
need to be given textures that impart the flair and atmosphere of a natural landscape. 

You will find a range of ground textures in the surface editor's texture catalogue which you can select, edit and apply.
The process is simple:

• Select the desired texture from the texture catalogue with the help of the preview.
• Click on the colour palette to adapt the tint colour and, if necessary, correct the scale, orientation or rotation.
• Adjust the spray jet: the bigger the jet, the bigger the area you can spray.
• Click on the icon that activates the spray gun, and drag the mouse over the area that you want to cover with the

selected texture while holding the mouse button.

The sprayed textures are depicted in the layout plan as coloured rectangles in the selected base colour, which create a
natural appearance thanks to the randomly generated shading. This does not mean, however, that you have to accept
the texture with all of the pre-defined settings. Experiment a bit to find out which colour nuance, scale and orientation
achieves the best effect.

The Fill layout with a texture function in the Edit menu gives you the option of applying a new texture and/or colour
to the entire layout in a single click:
• Activate the 2D editor for surface design

• In the texture settings menu, select the desired ground texture and – if desired – a different background colour 
(by clicking on the Surface texture tinting button)

• Then click on the Surface texture option in the Edit menu and then on the Fill layout with a texture in the 
sub-menu that opens.

That's it. After a short processing time, your layout will appear with its new look.

To be on the safe side: save a layout you are still building under a new name, preferably after each step of develop-
ment, so that you can trace the editing stages and, if necessary, access older versions! To play it safe, it is recommended
that you enable the auto save option in the programme settings and to set the interval at which your work is automat-
ically saved. You will find the saved work steps in the folder Ressourcen/ Anlagen/AutoSave.
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A path (that differs from the default) to an existing folder can be selected in the dialogue window of the programme
settings to act as the new save locations for your layouts. This folder can be created on an external drive, which is espe-
cially advantageous if you installed EEP 13 on an SSD hard disk (Solid State Drive), which (these days at least) have a
relatively low storage capacity.

4.3.2 Relief and surface design with the 3D editor
The 3D editor is accessed in the 3D view by clicking on the button with the little digger in the bottom-left corner of the
control dialogue. Once the editor has been switched on, a flashing message that the 3D surface creation mode is active
will appear in the 3D window. Train traffic and automated vehicle controls will be paused while you are in this mode.
This allows you to work in the 3D editor undisturbed.

Auch in der 3D-Ansicht kann die Landschaft bearbeitet werden
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The 3D editor provides everything you need for the surface design of your layout. In addition to a huge range of ground
textures, you will also find a multitude of tools which you can use to sculpt the relief and the landscape surface. Many
have been constructed so that you can perform two actions with opposite effect with the same tool. To achieve the oppo-
site effect, you must use the tool by holding down the left mouse button and the [Ctrl] key (on the left side of the
keyboard) at the same time.

Try out the alternative application of these tools:
• Click on the first tool, which is designed for modelling mountains and hills, and move the mouse cursor to the surface

in the 3D window that you would like to edit. A field made up of white squares will now appear there. You will generate
your mountain within these markings.

• Now enable the same tool again and simultaneously hold down the mouse button and the left [Ctrl] key. As you 
will immediately notice, a field of green squares will now be shown in the 3D window. The green colour indicates

that, instead of an elevati-
on, a depression will be ge-
nerated.

Linke Maustaste: 
Gelände erhöhen, 
linke [Strg]-  und  linke 
Maustaste: Gelände senken

Werkzeugdialog für die Bearbeitung der Landschaft im 3D-Fenster
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You can alter the landscape as you desire using the tools of the 3D terrain editor.

 Create elevation or depression (left [Ctrl] key) with soft apex

 Create elevation or depression (left [Ctrl] key) with pointed apex

 Build flattened plateau or depression (left [Ctrl] key)

 Smooth unevenness or increase erosion effect (left [Ctrl] key)

 Take height sample (with left [Ctrl] key held down) and apply this height to other regions

 Create slope

 Increase or decrease (left [Ctrl] key) brightness of ground texture

 Take ground texture sample with the pipette (if no texture motif is selected)

 Apply selected ground texture to surface (if no texture motif is selected)

You can change the scale of a ground texture. The slider for this ranges from 10% to 1000%, i.e. from one tenth to ten
times the original size. If moved to the far right, it will activate random mode, which will automatically vary the size
between these two base values during the application. This is effective against recognisable repetition of the texture
effect.

Oberfläche mit der gewählten Bodentextur überziehen (wenn kein Texturmotiv gewählt ist)
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Take a look at the video about this feature: www.eep11.com/tutorials 

 Rotate orientation of the ground texture / straighten a rotated ground texture

 Change scale of the texture / reset scale to original value of 100%

 Lock landscape surface against changes or unlock (left [Ctrl] key)

 Create shine effects by mirrored (specular) light on surface that can reflect
incident light (e.g. water)

 Switch selected ground texture regardless of the set size of the spraying tool. This is 
important for changing one specific ground texture for another texture. After activating
this tool, a white arrow appears first which you use to select the surface texture you 
wish to replace. You can select a different texture for replacement at any time by 
holding the [Ctrl] key.

 Opening the automatic surface generator

The automatic surface generator works in two ways:

1. It only changes the landscape surface in the marked area. For this, the desired areas of the layout's landscape surface
must be marked in advance.

2. It changes the landscape surface of the entire layout, excluding those areas that have previously been marked (locked)
against change.

There are various sliders belonging to the tools that are used to texture the landscape surfaces. Use these 
sliders to:
• set the angle for the orientation of the ground texture (on a scale of -45° to +45°) when the ground texture orientation

tool is active,

Die automatische Oberflächengenerierung sollte auf
einen begrenzten Bereich eingeschränkt sein
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• scale the editing area, which can alternatively be done using the Comma [,] and Point [.] keys,
• enlarge or shrink the applied ground texture (on a scale from 10% to 400%) when the scaling tool is active,
• set the size of the brush,
• set the intensity of the shading used to darken the ground texture in a random pattern. Smaller values achieve the

best results here.

In addition to ground textures in all categories imaginable, there are also ten pre-defined texture motifs available in the
3D terrain editor that you can select, edit and add new motifs to. Ground texture or texture motif? It's your choice, but
you have to choose one of the two. You can only apply individual textures if a motif is not selected.

If you prefer to apply single ground textures, you must select the option ### No Motif ### from the menu before 
choosing the category and texture. If the tint doesn't appeal to you, click on the Colour button to define or select 
the desired shade in the displayed colour palette.

The graphics engine allows for a technology known as parallax bump mapping. By using so-called bump mapping tex-
tures, a relative displacement (parallax) of parts of a ground texture in relation to the observer is calculated to achieve
a more intense three-dimensional effect. If you view a layout surface sprayed with a bump map from close proximity,
you will notice the fine height differences and grains emphasised by light and shadow. Grooves between paving slabs,
individual stones on a country lane, ice floes on a frozen river and cobbles on a cobblestone road – these all appear in
a vividness that can only be realised with bump mapping textures.

Each of the ground textures in the selection window are marked with a red square or a blue cube. The red squares denote
two-dimensional ground textures, while the blue cubes indicate three-dimensional bump mapping textures, which can
achieve a more intense and vivid layout surface. A more natural surface appearance can be achieved by working with
texture motifs.

Eine einfache Bodentextur benötigt kein Motiv
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Remember: 
One texture motif comprises four ground textures that vary in their mix and shading, and thus simulate an almost natural
appearance. The texture that is sprayed is determined by the angle of the landscape surface's inclination, which must
be set for each of the four textures. As the relief and surface design are linked, the pre-set textures are applied while
modelling the relief.

In this way, you can model steep mountains and undulating hills and slopes that are covered with the correct texture in
one step. You can see how a texture set varies in detail if you select a texture motif:  once a motif has been selected, the
four different textures appear in the small preview windows on the right which you can modify using the colour palette,
if desired. Additionally, a landscape surface activation angle is displayed for each texture, which can also be adjusted
using the assigned controls. To expand the scope of design, you can expand the range of motifs by compiling new texture
motifs.

The process is simple:

• Click on the New button in the dialogue in the 3D editor and enter a name for the new motif.

• Select a ground texture in the texture menu, which will now appear in the preview windows and which you can tint
if desired and insert into the new motif.

• To assign the texture to its position in the texture motif, right-click on the texture in the preview window. A new 
menu will appear.

• Move the mouse cursor to the option that assigns the texture to the desired place in the motive. The order does not
matter as the application is not decided by the position. Which of the four textures is used is determined solely by the
angle of the landscape surface.

• Once the texture has been placed and appears in one of the four texture boxes, you can set the landscape surface
angle that determines when the texture is applied using the assigned control buttons. If you enter 0° for the first 

texture, for example, the texture will be sprayed when the surface is even.

Gestaltungsspielraum
zur Erzeugung eigener
Bodentexturen
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• Then select and assign the remaining three ground textures to the boxes of the texture motif, and assign different an-
gles of inclination to them.

• Store your new texture motif after reviewing the result in 3D view by clicking on the Save button. If the angle is 
set to zero for all four textures, a random generator will activate automatically, which mixes all four textures
randomly so that the landscape surface does not appear lifeless and monotonous.

Block function for copying and saving the landscape surface:

In response to many requests from EEP users, a block function has been implemented in the surface design 3D 
editor, which can copy and save the area of the landscape surface you have selected. This not only allows the repro-
duction of a segment of the landscape surface within the open layout, but also allows the use of a saved block in 
other layouts. The copied and saved blocks of the landscape surface contain all the information about the textures 
used (so-called spray textures) and can also be rotated by 90°, as well as scaled in size by +/- 25%. Thus, you 
have practically all the tools you need for copying and editing well-modelled 'landscape spots', such as mountains and
lakes. 

To mark a block in the 3D editor, the button for marking and locking the landscape surface first needs to be pressed, and
then the desired section of the landscape surface must be marked by pressing and holding the left mouse button. The
marked area of the layout surface will be tagged with little yellow crosses, which also symbolises the content of the
block.

So können Sie bestimmte Areale
von einer weiteren Bearbeitung
ausschließen. Mit gehaltener
linker Strg-Taste kann die Sper-
rung wieder aufgehoben
werden.
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The marking does not need to be completed in one step as the placed marking will remain on the landscape surface
when you release the left mouse button. In this way, you can mark very selectively and precisely, especially as the size
of the marking tool can be altered with the brush size slider. If you have marked slightly too much of the surface, this is
not a problem: by holding the [Ctrl] key on your computer keyboard, you can undo the unwanted marks, or you can also
use the Undo/Redo functions.

Once an area has been marked, right-click it and choose Copy from the context menu. The mouse cursor must be located
within the marked area, otherwise it will not be possible to copy the marked area.

Once the marked area has been copied, you can move the mouse cursor in any direction, whereupon a 'mould' of the
copied section of the landscape will immediately appear under the mouse cursor. The – initially empty – shell of the
landscape can be moved to another position until you press the left mouse button, which immediately inserts the copied
fragment. Before inserting the copied landscape section, you can perform other operations via the right mouse button
menu, such as rotate the copied area 90° clockwise or anti-clockwise, or scale (enlarge or shrink) it in 25% steps. This
approach to copying the landscape is recommended mainly if the copied section is being placed (inserted) in close prox-
imity. 

For greater distances and, of course, when reusing the copied area in other layouts, it is also recommended to save the
copied area as a block.

Saving the copied area as a landscape surface block (*.bl1):

If the copied section of the landscape surface is not being inserted immediately, it can be saved as a block for future 
use. To do so, move the mouse cursor to the programme bar and select the option 'Save block' from the File menu 
to open the dialogue window for saving the block file. Of course, you can also use the icon buttons in the block 
sections for this.

Mit einem Rechtsklick auf das
markierte Areal wird ein Kopieren
möglich.
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Landscape surface blocks with the file extension '*.bl1' are saved by default in the
sub-folder 'Resourcen/Blocks/Terrain', and can also be accessed from there. You 
can also save block files in any location on your hard disk. Of course, the saved 
blocks can be loaded via the File menu or the button for opening blocks, which how-
ever requires there to be currently no copied area of the landscape surface in the
memory. If there is, right-click and select the Empty block or marked area command
from the menu. 

Good to know: A freshly loaded block or a copied area of landscape surface that you wish to insert adapts
automatically to the height of the terrain, even if the option Match object position height to surface is
not active!

Tip: The content of a block is dependent on the grid density of the layout and – if possible – is auto-
matically adapted. If you use dramatically different grid densities in your layouts, e.g. 150 grid nodes 
per km in one layout and 500 in another, it may still be necessary to scale loaded blocks. The dimensions 
of the loaded block can be scaled to twice or half its original size via the menu that appears when you 
right-click if you click Increase/Decrease by 25% multiple times. You can achieve great results when 
copying and inserting landscape surface blocks if the layouts have roughly the same or, ideally, identical
grid densities.

4.4 Defining environmental and weather conditions

The natural appearance of a landscape is never constant, but it changes with the light conditions, the weather, the time
of day, and the seasons. Therefore, these influences should also be taken into consideration in your railway landscape on
screen. The global settings for the light and weather conditions are set in the View dialogue, which can be opened by
clicking on the corresponding button in the tool bar.

Kopieren und speichern von Landschafts -
blöcken über das Datei-Menü
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First select Day or Night or EEP time in the View dialogue.
If you choose EEP time, the day and night cycle will be 
controlled by the system time. Additionally, you can regu-
late the intensity of the rain, snow, sun, moon and wind
using the individual sliders. If you would like the weather
to change randomly, the corresponding option must be
activated.

Clouds are not just clouds, so the Clouds option in the
View dialogue can now be selected and set at different
levels: if the option is not enabled, the sky will appear
cloudless. If the option is enabled with a mouse click 
and a check is placed in the box, there will be light 
cloud cover. A second click in the check box increases the
effect: to signify this, the check box turns grey, while 
the clouds gather and the sky darkens. A second click 
also increases the strength of the sun, with the effect of the
sun never being completely obscured, even with heavy
cloud cover.

Hier legen Sie die Einstellungen zur Umwelt fest

Ein bewölkter Tag am See
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There is another slider in the environment settings dialogue window for fog. Unlike the distant haze that is intended 
to conceal the transition to the horizon and is mathematically derived from a power function, the fog is a 'linear 
phenomenon'. The fog can be set globally for the entire layout or in individual weather zones, which allows fog banks
to be implemented very precisely. What was previously only implemented via visibility (i.e. the haze), can now be
 implemented as local fog – completely irrespective of the actual visual range, which can also be set individually in the
weather zones.

Good to know: Logically, it can only rain if there are clouds and the corresponding setting is active. At a
rain intensity of more than 50%, a real thunderstorm might break occasionally above your railway land-
scape. The more intense the rain, the more often you'll have thunder and lightning.

Tip: The Snow weather option has been expanded with a Sleet variant. If you would like to activate this
weather option, click the Snow option a second time. The check box will then appear in grey and the show
flakes will be transformed into sleet pellets.

Independent of the weather, you can define the sky colour for the day and night time. For example, to set the sky 
colour for at daybreak or sunset, all you need to do is to click the button for the corresponding time of day, and select
the desired shade in the colour palette that then appears. The different gradations of sky colour allow your layout 

Schieberegler für den Nebel in
einer Wetterzone
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to appear in different lights over the course of time – both when the time is changed manually and with the auto-
matic passing of the EEP time (Extras menu -> Time properties). The settings are saved with the layout data 
so that the character of each layout is emphasised by the special lighting and colours. In addition to the time of day and
the light and weather effect, the visibility in the 3D view can also be set and a horizon theme can be selected as the
backdrop. 

You can set the season under Seasons in the settings dialogue. This setting, however, does not affect the landscape's
appearance in general, but only dawn and dusk and the position of the sun, which varies with the changes of the seasons.
Setting the compass points allows the perceived orbit of the sun and moon to be rotated by 90°, 180° or 270°. This does
not affect the orientation of the layout.

Setting up local weather zones:
The settings made for the light and weather conditions in the View dialogue apply globally to the layout for which they
have been defined and saved. Irrespective of these, however, you can create different weather zones in the same layout.
This will cause the weather conditions – depending on the local setting – to change as the camera and observer travel
through different weather zones. Thus, rain can turn to snow at high altitudes, and snow into rain in the lowlands, just
to name one possibility.

The zones, each defined by its own weather settings, are drawn in the 2D view by clicking on the but-
ton in the surface editor:

• Click on the button that activates the mode for creating local weather zones.

• Switch to the layout plan using the mouse cursor, which is now in the shape of a cloud, and define the various weather
zones by clicking and holding the mouse button. Draw the weather zone, which are displayed in the form or blue
circles and which can be scaled and moved if required, overlapping if possible so that the transitions between the we-
ather zones is gentle and doesn't happen abruptly.

• Left-click weather zones you would like to delete and then press the [Del] key.

Even though the weather zones are depicted as circles in the 2D window, they are actually three-dimensional balls whose
centres are defined by the co-ordinates X, Y and Z (for the height). If you create weather zones in a mountainous land-
scape, you must keep an eye on the heights at the centre of the individual weather zones as these only adapt to the
height of the terrain when they are first inserted. If a weather zone is moved, the height at its centre needs to be man-
ually adjusted to match the terrain.

Attention: 
When moving the camera in one or multiple weather zones, the maximum value for the respective weather
conditions is achieved when reaching 50% of the weather zone's diameter. As a consequence, the weather
changes abruptly if a new camera is positioned at the centre of a weather zone!
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The weather settings in the local weather zones are defined in the corresponding dialogue which appears when you
right-click on the associated circle in the planning window. You can set the intensity of rain, snow and wind and the Vis-
ibility in 3D View for each weather zone, and decide whether the sun, moon, stars and clouds should be visible. As the
setting also includes visibility and wind force, depending on the terrain, fog banks can be formed in narrow valleys and
blasts of wind on open terrain.

4.5 Inserting landscape elements and structures

Once you have modelled the relief and the surface of the layout, the detailed work begins. Now it is time to populate
the empty landscape, to plant trees and to place houses. Whether you require landscape elements or real estate, both
are provided for: there is an editor for each with a wide range of models.

Placing landscape elements:
Unlike the relief and surface modelling editors, the editor for landscape elements does not have a tool palette, but instead
comes with a large catalogue that is subdivided by category and genus. Whether you're looking for flora, fauna or sound-
scapes, here you will find everything you need to bring your railway landscape to life. How do you get objects out of the
catalogue and into the layout? 

Einstellungen in der
jeweiligen Wetter-
zone
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Inserting them is just as easy as selecting them:

• Open the landscape elements editor in the 2D view and open the catalogue of the same name.

• Choose the category and the genus, peruse the models that are now listed in the selection area below, and make your
selection with the help of the preview feature.

• Switch to the layout plan using the mouse cursor and place the selected object with a simple click of the mouse.

Placing landscape elements in the planning window

Selected models are usually displayed in animated 3D in the preview window. If you would like to stop the automatic
rotation, click on the 3D area in the preview window and press the [Insert] key. In this state, the preview object can be
put in the desired position by clicking and holding the right mouse button. The distance can also be set in the model
preview by rolling the scroll wheel forwards or backwards. To turn the automatic rotation back on, press the [Insert]
key again.
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No matter whether you're placing a tuft of grass or a cow in a landscape, the procedure is the same. Just like flora and
fauna objects, soundscapes can also be inserted into the layout plan which, though not visible in 3D view, can be per-
ceived acoustically – provided your computer has a sound card.

To make the scenarios as natural and vibrant as possible, a special model named 'Falling leaves (with 50 m 
range)' is available, which simulates leaves floating in the wind. This model, which is displayed as a cube in the 
preview window, but which appears as falling leaves in the layout, can be placed both in 2D and 3D modes. 
The simulation of falling leaves is generated in an imaginary cylinder 20 m high with a radius of 50 m. Falling leaves 
are shown within this area, which appears in the form of a hatched green circle in the planning window, at
irregular intervals, with the fall direction, amount and fall speed depending on the strength of the wind. Of course,
you can then only see the leaves fall when the camera is located within the model's 50-m-wide radius.

The placement of natural and landscape objects does not require a great degree of precision. While a model is selected,
it can be moved at will to the desired position, not only in the drawing mode in the 2D view, but also 'live' in 3D view if
the 3D editor is active. Give it a try:

• Switch to the 3D editor and select the model with the left mouse button. The gizmo (see Chapter 2.3) will be activated
and you can use it to move, rotate and scale the model. If you would like to move the model freely in all directions, hold
down the [Shift] key to temporarily deactivate the gizmo. Four white arrows around the model show you that you can
now position it freely. To change its altitude, please hold down the [Ctrl] key as well. When moving an object –
whether freely or with the gizmo – please pay attention to the 'Match object position height to surface' in the
Insert menu. If this is active, the model will follow the contours of the ground, and it will be reset to ground height as
soon as you move it.

You can also position and rotate selected models in the drawing mode of the 2D view – most easily with the 
mouse or, if you need to be precise, in the dialogue window opened by right-clicking on the selected object in 
order to determine the position, rotation and if necessary also the scale exactly by entering the corresponding param-
eters.

Steuerdialog zum Einsetzen von Immobilien im 3D-Fenster
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Sowohl in der 3D-Ansicht als auch im Radarfenster lassen sich Immobilien genau justieren

Dialog zur Positionierung
von Objekten in der 2D-Ansicht
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Inserting blocks:
Of course, you don't have to place every tuft of grass and each tree separately to plant greenery on your layout. With 
the help of the block function, the effort can be streamlined. A forest, for example, can be created faster if the trees 
aren't inserted individually, but rather in blocks, as blocks are handled as objects that, just like any other object, can be
saved, copied and inserted again.

Selected block in the 2D plan

The process is simple:
• Place and arrange the bushes and trees that will make up your forest in the layout plan so that they can be 

grouped.
• Choose the tool that selects blocks from the tool bar and draw a selection box around the entire group by clicking and

holding the left mouse button.
•  Release the mouse button. The objects within the selection are now treated as a block which you can now copy and

paste in other locations.
• A forest can be built much faster by repeatedly copying, moving and rotating small blocks.
• You can save selected blocks for later use. Select this option either from the File menu or via the corresponding icon

in the tool bar.
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Good to know: While holding the [Ctrl] key, you can remove individual models from the selected block
before saving or copying it.

Inserting and saving blocks:

The selection of blocks depends on
the editor. If you are in the land-
scape editor, you will only be able to
select landscape elements; in the
structures editor, only buildings and
furnishings; in the track editor, only
tracks. Choose the blue cube as the
mode to select a block that contains
models from all categories (except
signals, contacts and rolling stock).
In this way, you can select and save,
for example, your entire station
along with its tracks, accesses, plat-
forms, etc. and insert them later in a
different location. 
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You are not limited to rectangular
frames with the block tool. Hold down
the [Shift] key to draw a closed free-
hand shape around all the elements
you would like to copy.

Inserting structures:
Just as with natural and landscape elements, you can populate your layout with architectural objects, which you 
will find in the structures editor. The structures catalogue is more diverse than the landscape editor catalogue, but 
otherwise structured the same way.

Among other things, EEP also has clocks with indi-
vidual hands and smooth movement of the second
hand (even with a spring-change on the minute
hand). For these clocks, which can be found in the
folder Verkehr\Bahnsteigsysteme\ in the structures
editor catalogue, the rigid mechanism of a com-
puter timer, which only shows the time in
increments of a second, has been replaced with an
algorithm that converts the current frame rate with
respect to the time elapsed, which allows for the
smooth movement of the second hand and the so-
called minute jump.

You will find not only buildings in the folders of the structures editor, but also walls, doors and furnishings of all kinds.
Model selection and placement in the layout plan is done exactly the same as landscape elements. Whether landscape
elements or structures, placement and editing in construction mode may be easy, clear and precise, but it only ever dis-
plays the objects in the abstract planning or drawing view. Thus, the 3D editor offers much better options. 

Attention: 
Additionally purchased models are automatically added to the New models / Recently installed category.
The Scan models File command sorts them into their appropriate categories.

Lasso-Funktion im 2D-Plan

Uhren mit Zeitansage
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Inserting and editing landscape objects and structures with the 3D object editor:

The 3D editor is accessed by clicking on
the button shown in the control dia-
logue. The flashing note in the 3D
window signals that the 3D editor
mode is active. As not only objects that
have already been placed can be edited
in this mode, but also new objects
added and edited, the list boxes for the
individual editors are shown in the con-
trol dialogue so that you can select
your models in the 3D view, inspect
them in the preview window and place
them in your layout.

The features for editing objects in 3D mode can be accessed via the context menu or object menu – just like in 2D mode
– which can be opened as usual by right-clicking on the selected object. The commands in this menu allow you to 
move, scale, rotate or even delete your model in the 3D view. If you want to specify the object's position, select 
the Model Properties option in the object menu and enter the values that define the position, rotation and scale in
the following dialogue. However you rotate or turn an object selected for editing, it will automatically adapt to the 
surface and level of the landscape. Occasionally, however, it may be useful to correct the height or depth. To do this, 

hold down the left mouse button and
[Ctrl] key simultaneously and drag the
selected object vertically up or down.

Einsetz- und Eigenschaftendialog
in der 3D-Ansicht

Verschieben von Objekten mit gehaltener
linker Maustaste, Höhe mit zusätzlich
gedruckter Strg-Taste
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Illuminating structures:
Even if landscape objects and structures are selected, placed and edited in the same way, there are still differences due
to the different properties and which are evident in both the functionality and appearance. An example of the special
object properties of structures is the illumination feature which ensure that the light don't need to go out when night
falls over your layout. As with the landscape elements, there is also an object dialogue for structures which you can open
by right-clicking on the selected object in the 2D window. Not only can you enter the parameters to determine the posi-
tion there, but also play around with light and smoke: if you choose the Light on option, it becomes bright; if you opt for
Light off, it stays dark. 
The same goes for smoke. If you enable the Smoke option, the chimney will smoke, provided the structure has a chimney.
The illumination function is also expanded by a feature that allows the lights in a structure to be turned on and off auto-

matically at random. The automatic switching, which occurs at arbitrary
intervals of 30 to 60 seconds, is subject to a random generator which –
like manual lighting – needs to be enabled for each structure individually
in the object dialogue. To turn the random generator on, you need to click
the option Lights on/off/auto several times. Automatic light switching is
active when an X appears in the option box instead of a tick.

Fire in structures:
Even more spectacular than the randomly control lighting effect is the outbreak of fire, which you can switch on manually

or via a contact. This feature, which could first be
admired in the Knuffingen model train layout, is
however only available in the functional models
that have been specifically designed for this pur-
pose and which can be selected and placed using
the structures editor.

Für die Lichteinstellung gibt es drei Zustände: ein, aus, automatisch

Feuerwehreinsatz in EEP – neue Feuerwehr-
Modelle gibt es im Shop unter www.eep.eu;
sinnigerweise von Hans Brand
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If you would like to trigger the fire in one of these buildings manually, select the structure in the 2D window, right-click
to open the properties dialogue from the menu, and switch on the Fire on/off option. With this option enabled, the 
building will be ablaze in just a matter of seconds. If you remove the tick that activated this feature, the fire will be extin-
guished just as quickly. 

To simulate a complex firefighting operation, the fire can also be controlled automatically using contacts. In contrast
with the manual controls, the automatic controls are assigned to the signal control editor via contacts, so you will need
to switch from the structures editor to signal control. Here, select the structure contact in the contacts list, then switch
to the planning window and place the desired number of contacts for the automatic control of the operation on the des-
ignated traffic route using the left mouse button.

Once the contacts that control
the sequence of events have
been placed, right-click on the
contacts in order to open the
control dialogue for each con-
tact. From there, select the
rolling stock that trigger the fire
and set the intensity of fire and
smoke, and if necessary the set-
ting relating to individual axes,
the direction of travel and the
route.

The more contacts you set, the more fire vehicles can be involved, and so multiple blazes can also be fought simultane-
ously on a certain time delay. The fire is finally extinguished the way it was started: via a contact, only this time you have
to set the fire intensity to zero in the properties dialogue. Of course, vehicles with extinguishing water and water cannons
need to be deployed to extinguish major fires. This is mentioned here only for the sake of completeness, and is dealt
with in detail in the context of signal control, which is documented in its own chapter.

Auch Kontaktpunkte für 
Immobilien werden im 
Signaleditor gesetzt
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Structures with moveable axes:
The architectural objects with extended functionality also include structures with moving parts such as cranes, wind
turbines of mill, to list just a few examples. The respective objects can be selected in the structures editor in the 2D 
view and moved manually in the 3D view. In doing so, both the type and the intensity of the movement is controlled
using a combination of the mouse and keyboard.

The movements that can be produced are:

 First left-click                –   a short movement or a movement to the next pre-defined angle (turntables)

 Second left-click          –   a stop

 Left-click + [Shift]      –   a continuous movement to the possible end

 Left-click + [Ctrl]         –   a reversal of the continuous movement to the next pre-defined angle

 Right-click + [Shift]    –   an acceleration

 Right-click + [Ctrl]     –   a slowdown of the movement

Once set in motion, the movements triggered this way are preserved, even if the layout is closed and re-opened again
later.  All moving parts in interactive structures can be controlled via contacts embedded in the tracks to switch the
movements of the axes on and off, or to move the axes to a position pre-defined by the user. In this way, engine shed
gates can be automatically opened and closed by an approaching locomotive, for example. The position of the turntable
can now also be controlled so that it automatically adjusts itself to the position of the locomotive. And the moving 
parts in other structures, such as the loader of a coaling facility or the filling pipe of a water crane, can also be controlled
automatically using contacts.

Durch Rechtsklick auf den Kontaktpunkt
öffnen Sie den Einstellungsdialog
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As with fire in structures, the automatic control of moveable axes is also handled via the signal control. In order to place
the contacts on the desired track, the structure contact must once again be active in the signal control editor and the
respective structure selected in the layout plan. Once all contacts have been set, open the configuration menu for each
contact as usual to configure the vehicle, the corresponding axis and its movement in the Action menu.

4.5.1 Shadows for landscape elements and structures

The shadow of each structure
and landscape element can be
set individually. As shadows
require additional processing
effort, it can be advantageous to
disable shadows in invisible
areas, such as in the middle of
forests. Use the block tool to
modify the shadows of entire
groups of models.

Ein Rechtsklick auf den Kontaktpunkt in der 
3D-Ansicht führt über das Auswahlmenü zu den
Objekteigenschaften
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4.5.2 Random variation when placing landscape elements and structures (new in EEP 13 Expert)

Landscape elements are often built in large num-
ber and only the size and orientation vary. EEP now
supports you by automatically varying the scale
and rotation with each click. The button high-
lighted in red in the picture on the right opens a
menu where you can activate this option and spec-
ify the limit values for the variations.

4.6. Building traffic networks

The core of a model railway is its rail system. Everything else a layout has to offer and show is secondary to its traffic
system. Building a functioning traffic network with differentiated tracks is the task that we will now tackle and master. 
The track layer editors are selected in the 2D view via the buttons in the vertical tab bar.

Rail track editor: This part of the route editor allows you to lay railway track on your layout.

Road editor: This editor provides you with various styles of country and city roads.

Light railway track editor: In this editor you will find special track styles for trams, as well as a side conductor rail as
used in the 'S-Bahn' commuter train systems in Berlin and Hamburg, a track for a monorail and a suspension rope
for a funicular railway.

Auxiliary splines: In this editor you will find all the models that cannot be assigned to the other three categories. These
are waterways, such as streams and rivers, invisible routes of air traffic and the dolly track for the mobile camera.
You will also find models that are not track or routes here but which can be laid the same way: telegraph lines,
hedges, fences, etc.

The traffic system of an EEP layout is essentially based on flexible segments that can be freely laid, moved into and out
of position, shaped and combined with each other in their editors – this applies to all four of the editors introduced
here. The different editors only vary slightly in their functionality and structure. Whether you're laying tracks or roads,
the procedure is always the same. And it's all about the tracks in a model railway, we'll restrict ourselves to the construc-
tion of a track system with the example of the track editor.

Important: 
Please note that only one editor can be active at once. The strict separation and division if the traffic system
into four editors simplifies the overview and protects against accidental improper use.
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4.6.1 Laying tracks

Before you start building a rail system, you should familiarise yourself with the features and tools.

In the tool palette of the track editor you will find:

• a track style selection menu,

• buttons for laying and deleting track sections and
turnouts,

• an input field to determine the track height, as
well as a tool that adapts the landscape surface to
the height of the track, and

• a button with radio buttons for duplicating track
sections.

The second tool dialogue contains a selection 
catalogue for trackside objects.

To construct a track system, first select a track style
from the selection menu. Dark or light track, only
sleepers, various tunnels, light rail, narrow-gauge
railway or transrapid? It's your choice. Once you have
made your decision, the actual work can begin:

• Click on the button in the editor field to enable the track-laying function.
• Move the mouse to the layout plan and click to place the first section of track.

Positioning the first piece of track is that quick and easy. The thin red arrows at the ends of the section of track 
indicate the directions for further track connections. The
green triangle at the start and the green dot at the end
mark the ends and show the direction. The direction is
important if a contact is placed on a section of track which
then needs to be configured. The green symbols are shown
again when the segment is selected for editing.

Gleis biegen

Gleis drehen Gleis verschieben

Die Werkzeugdialoge zum Gleiseditor



68

Editing tracks:
If a segment of track has been selected, it can be
edited just like any other object. Depending on the
form the mouse cursor takes, you can now move,
rotate, curve, compress and stretch the track – either
intuitively with the mouse or precisely in the config-
uration menu. To define the exact length of a track
segment, right-click on the selected track. This 
opens the configuration menu, where you can set the
track parameters:

• The start position is determined by the start co-
ordinates, the absolute and the relative height and
the angle that determines the position of the track
on the layout.

• The Characteristics area specifies the curvature 
if the track, which is dependent on the angle and
length of the track. Accordingly, you can enter 
either the angle and the track length or, alternati-
vely, the angle and the curve radius or the length
and the curve radius. In the same area, you can also
set the gradient – either as a percentage or in me-
tres.

• Finally, the cant defines the elevation of the outer rail and the depression of the inner rail of a curve. Unlike on 
straight stretches, where both rails of the track are at the same height, the outer rail can lie above the inner rail on a
curve to counteract the centrifugal force. The value for the elevation is entered in millimetres.

Connecting tracks:
What's next? Just as you laid the first piece of track, continue connecting piece after piece. It is automatically snapped
in place and the orientation also adapts automatically when the start of the track (green triangle) approaches the end
of a track. If a piece of track has a connection at both ends, its colour will change from yellow to blue.

Tip: Tracks are quicker and easier to lay in the new 3D editor mode.

Attention: 
The first and last pieces of track on a 'stretch' will remain yellow as they have unconnected ends.

Per Rechtsklick auf ein markiertes Gleis öffnet sich der 
Eigenschaftendialog für präzise  Eintragungen
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You can lay continuing and parallel tracks faster using the 'Duplicate track' feature:

• Set the direction in the Duplicate track editor field. For continuing track, choose the 'forward' option; for parallel
tracks, choose left, right, up or down.

• If you wish to lay the next track against the original laying direction, not at the end but at the beginning (green
triangle) of the first track, enable the 'reverse' option.

• Optionally, you can choose a different track style or even another traffic system for the copy by disabling 'Maintain
track style'.

• If you have previously selected a group of tracks using the block tool, all tracks in the group will be copied according
to your specifications. 

• Click the button to generate the desired copy.

Vertical bends in tracks
A piece of track can be bent for a smooth transition from 
a flat stretch to an inclination. For this, the deflection must
be entered in degrees in the "Characteristics" section of the
object properties. The deflection will be added to the angle
of inclination.

Die vertikale Biegung eines Gleises im 3D-Editor der Fahrwegmodule (Splines)
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EEP can calculate the connection of two separated track ends for you automatically.

• First activate the 2D track editor and select the Close gap command in the Edit menu. The open, unconnected track
ends will be marked with blue chevrons (triangles).

• Now click on the highlighted ends that you would like to connect.

• EEP creates a block containing the required connecting track. You can accept the block by clicking outside of the frame,
or discard it by pressing the [Del] key.

This only works, however, if the tracks have been laid in a way that a connection is both possible and plausible. 
The gap in the track cannot be closed automatically if the spacing between the tracks is too small or if there is a bend
of more than 180°. Any height differences, however, can be taken into account and evened out.

The virtual connection of tracks is also possible. At virtual connections, vehicles jump from one end of the track 
to the other. With this trick, you can avoid the tedious work of connecting one end of a route to a lower and far-off 
hidden depot via a huge spiral of track. If you prefer!

• Select the Virtual connection of tracks option in the Edit menu; all unconnected track ends will then be marked 
with blue chevrons (triangles).

• Now click on the highlighted ends that you would like to connect.  A virtual connection counts as a connection, 
and so previously yellow track ends now become blue. 

Electrifying tracks: 
#Electrified trains have been around for about a hundred years, so of course EEP model railway layouts shouldn't 
only be powered by steam and diesel. If you enable the somewhat inconspicuous Electric option, all the tracks you lay
will automatically be equipped with overhead power lines.

If you would like to go back and electrify a piece of track you have already laid, enable the corresponding option in the
configuration menu of the piece of track, which is opened as usual by right-clicking on the selected track. The following
figure at the top of page 71 shows both variants. 

A piece of electrified track is depicted with a line running down the centre of the track in the layout plan signifying the
overhead line, as well as with white circles marking appropriate positions for overhead line masts.

You can also use the electrification feature if you wish to lay telegraph lines of overhead power cables. However, 
the editor for auxiliary splines and air routes is used for this rather than the track editor. With this switched on, 
select the telegraph line track style and enable the Electric option. 

Only by enabling this option do the overhead lines of the invisible telegraph lines style also become visible. Catenaries
on electrified routes can also be laid in a zigzag course quickly and easily. With a course like this, the catenary wire doesn't
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run centrally, but with a lateral displacement to the centre of the track, preventing unilateral wear to the panto-
graphs. You can now determine how far the catenary wire is offset in relation to the start and end of the track easily
yet precisely using the slider in the track's properties dialogue. You will find matching masts in the structures 
editor in the folder Immobilien\Verkehr\Oberleitung.

Elektrifizierte Strecke

Stromleitungen finden Sie im Editor 
Wasserwege
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Inserting splines:
Placing overhead masts along an electrified route is relatively quick and easy if you use the spline function. This function
allows multiple catenary masts to be distributed evenly along a stretch of track and to be positioned and docked in 
one go. In doing so, objects placed on the spline curve do not need to be oriented to the height of the layout surface,
but can be adjusted to the height of the track. This allows even tracks that don't lie flat on the layout surface to be
equipped with catenary masts much more easily. You can allow objects to be adjusted to the height of the track by
 disabling the 'Match object position height to surface' option in the Insert menu.

How does it all work? Give it a try:
• Select Spline properties in the Extras menu.
• In the following properties dialogue, check the boxes: snap objects to 

grid and Angle relative to spline.
• Now click on the spline tool in the control bar to enable the spline

function. 
A spline line will then appear in the planning window.

• Now place the mouse cursor directly over the track you wish to add masts to.
• Press the right [Shift] key and click the mouse. That's it.

What happens?
The spline line is instantly placed on the target track and takes the exact same course. Now all you need to do is 

select the right mast in the structures editor.

The rest takes care of itself: When you click to place the mast in the layout plan, the masts are distributed 
exactly and evenly along the track.
Not only individual tracks but 
entire sections of track can be
equipped with catenary masts this
way. To extend the snap-to-grid
spline function to several tracks,
you also have to hold the right
[Ctrl] in addition to the right
[Shift] key. Whilst holding both
keys at the same time, you can
select the tracks to which the struc-
tures will be docked one by one.
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The spline function can be used manually as well as automatically, of course. If you would like to distribute objects 
 manually along a spline curve, disable the Snap objects to grid option in the Spline properties dialogue in order 
to determine the number of objects placed at the same time yourself. Objects will now no longer be positioned
 automatically, but will now be placed in manually determined locations along the curve.

The Angle relative to spline option should be switched on if you want to distribute overhead masts, lanterns or 
similar objects. If this option is disabled, all inserted objects will face the same direction; if it is active, however, the 
angle of the objects will follow the spline curve.

Once you have made the spline settings, click on the spline tool in the control bar to enable the spline function. 
The spline curve that is now shown is initially a straight line with round and square markings. The squares indicate 
the positions at which the objects are inserted. If the Snap objects to grid option has been enabled, the square 
and round markings will be identical in number and position; if it has been disabled, the squares will be distributed
evenly along the specified line.

You can change the position and the shape of the spline line by clicking and holding the round markings and 
dragging them to the desired positions. If you click on the curve whilst holding down the [Ctrl] key, you can add new
points as you wish and remove existing points. The more points a curve has, the better it can be made into the desired
shape. Once the squares are in the desired positions, objects can be selected and inserted as usual with a click of 
the mouse.  If the objects are facing the wrong direction, you can correct their orientation manually by double-clicking
on them one by one to turn them to face in the correct direction.

Inserting switches:
For a network with branching tracks, you need switches, which are quick to build and place with the track editor's 
ready-made components.

• First select a track style for your project. Then click on one of the two buttons to decide between a two or three-way
switch.

• Move the mouse to the planning window and click to place the switch point, possibly at the end of an existing track.
The switch point, depicted by a bar with a black square, is then placed.

• Now click on the button in the track editor to set and connect the first switch branch in the planning window. Once
the first branch is snapped in place, connect the second (and, if required, third) branch in the same manner. As the se-
cond switch branch generally needs to be curved, first lay this piece of track next to the building site.

• Then open the configuration menu for this piece of track. Choose the characteristics option you would like to work
with. Usually, this is the third option, Length + curve radius.

• Once you have entered the values, confirm by clicking OK and dock the curve piece of track with the switch point.

Once all branches of the turnout have been connected, a green arrow and a four-digit number will appear next
to the switch point in the planning window. The arrow denotes the switch lantern in the planning and overview
 windows, which shows the current setting of the switch and thus the passable direction. You will see the switch 
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lantern here in the 3D view. In this
view, you can operate both switches
and signals by clicking on them
whilst holding the [Shift] key. You
will be able to recognise areas where
you can operate switches as the
mouse pointer will turn into a hand
with an outstretched index finger.

If you would like to set the position
of the switch lantern, which can be
changed for each switch individu-
ally, switch back to the 2D view and
right-click on the switch point to
open the configuration menu.

Here you will be able to decide
whether the switch lantern is posi-
tioned to the left or right of the
track, or whether it should be made
invisible. If you choose the option
'Automatic', the software will decide

the position of the switch lantern. The position of the lantern to
the left or right of the track is determined by the laying order of
the branches of the switch and their angles. If you enable the Con-
nection to switch/signal option, you can create a logical
connection with another switch or a signal by specifying its ID. 
In EEP 13 you can also turn a switch's sound effect on or off.

Weiche im 2D-Plan

Weiche im 3D-Fenster

Weicheneinstellungen im Gleisdialog
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Attention:
If you choose the Hidden option, e.g. for a modern rail system with electronic switch points, no control
 element will be visible in the 3D view. As a consequence, the switch can only be set manually in the plan-
ning and overview window. Regardless of this, the switch can also be controlled automatically by one or
more contacts, of course.

Inserting track combinations:
Of course, constructing each switch individually takes a lot of time. You can save yourself this effort by using the track
combinations supplied, which you can select from the Edit menu and place in your layout with a simple click of 
the mouse. The selection is made up of freely changeable combinations of the following types:

                    • Branch line                        • Track harp
                    • Scissors crossover            • Arc
                    • Crossover                           • Double bend

Additionally, there are ready-made standard combinations for the types branch line, double slip switch, crossover and
scissors crossover, which cannot be modified individually. How to set these track combinations can be most easily under-
stood from the example of a branch line:

• Select the Track combination option from the Edit menu, and then the branch line type from the sub-menu.
The branch line configuration menu will then appear.

• Set the angle and the radius of the branch line here, as well as the spacing to the parallel track.

• Then set the direction of the curved switch branch and click on OK to create a ready-to-use branch line.

Choosing a standard combination bypasses the
 dialogue. However, the downside is that the parame-
ters of default combinations cannot be adjusted. Track
combinations apply with OK appear as blocks in the
layout plan and can still be rotated and moved while
selected. Once it is in the right position, double-click-
ing outside of the selection sets it.

Dialog zur Abzweigung, über den Menüpunkt Bearbeiten
unter Gleiskombination aufrufbar 
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If you want to connect a branch line or another track combination to a track you have already laid, it can simply be docked
and snapped in place:

• Drag the selected block with the track combination whilst holding the left mouse button and left [Shift] key towards
the laid track. Once the block's connecting track end is in the immediate vicinity of the laid track, the block will auto-
matically dock.

• Now double-click outside the selected area to dock the track combination seamlessly onto the existing track.

Double slip switches:
The double slip switches ('DS' for short) receive
 special treatment amongst the track combinations.
Even though these are track objects that are inserted
completely into the track layout, a DS can be set like
any other switch, both manually and automatically
using contacts. As with its real-life counterpart, the
double slip switch in EEP also has a special DS lantern
that shows the current switch setting. The setting of
the DS lantern can be controlled in the 3D window 
as well as in the planning or overview windows. 
A single left-click on the DS lantern – whilst also
holding the [Shift] key in the 3D window – or on the
corresponding button in the planning window cycles
the DS through one of four possible positions. The

 figures show how the DS signals are
displayed in the 3D and planning win-
dows, and how the DS can be set using
contacts in the dialogue window.  EEP
13 also includes double slip switches.
You can find these in the track editor by
clicking on the button and on the 
Animated track objects in the Track
objects catalogue. The number in the
name of the double slip switches
 provide information on the track geom-
etry, i.e. about the radius, the grade
expressed as a ratio, and (in brackets)
the track spacing for the parallel tracks
where double slip switches can be used.
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DS track geometry
Radius: Even in the time of the state railway, the radius determined the maximum speed, with the radius originally
being measured from the outer rail, and later in the centre of the track by the German State Railways (DRG) – 'Deutsche
Bundesbahn' (DB) and 'Deutsche Reichsbahn' (DR). The following standard radii have been defined:

Radius of 190 m = 40 km/h Radius of 760 m = 80 km/h (introduced by the DB at the start of the 1950s)

Radius of 300 m = 50 km/h Radius of 1200 m = 100 km/h

Radius of 500 m = 60 km/h Radius of 2600 m = 120 km/h (introduced by the DB in the 1960s)

Grade: The grade of a double slip switch is the tangent of the switch angle and is expressed as a ratio. The following
grades were used by the DRG (and later):

1:6.6 1:7.5 1:9 1:12 1:14 1:18.5

Expressed in degrees (rounded): 8.6° 7.6° 6.4° 4.8° 4.1° 3.1°

Properties of the included DS models

DS 190 1:9        The straights are each 40.36 m long and are 2.25 m apart at the end 
                                      (parallel spacing 4.5 m), switch radius 190 m, grade 1:9 (approximately equal to 6.4°).

DS 190 1:6.6     The straights are each 47.20 m long and are 3.50 m apart at the end  (parallel spacing 7.0 m), 
                                      switch radius 190 m with intermediate straights of 6 m, grade 1:6.6 (approximately 
                                      equal to 8.6°).

DS 300 1:9        The straights are each 40.36 m long and are 2.25 m apart at the end (parallel spacing 4.5 m), 
                                      switch radius 300 m, grade 1:9 (approximately equal to 6.4°).

DS 500 1:9        The straights are each 62.89 m long and are 3.50 m apart at the end (parallel spacing 7.0 m), 
                                      switch radius 500 m, grade 1:9 (approximately equal to 6.4°).

Pay attention to the position of the DS when building automatic switches as the switch signal is read from left to right.
At the location of a DS cannot simply be set like a simple switch (to the left or right of the track), you will find some 
DS models in the catalogue with the switch lantern on the left side of the tracks, labelled 'L'.

Nevertheless, 'normal' DS models can, of course, be rotated through 180° to change the position of the switch lantern
from right to left. When controlling rotated models via contacts, you must, however, bear in mind that the leading
 direction has been reversed, so that is now from right to left. As track geometry is the same for both normal left and
right DS models, only the position of the switch lantern changes from right to left in the 3D view. The included double
slip switches have been implemented as track objects for technical reasons and consist of a total of eight connec-
ted track pieces: four switch points and four connecting tracks. If one of these eight track pieces is deleted, the DS
track combination is removed and the entire track object is deleted. The following must be considered when placing and
connecting a DS to the existing track network: 
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When a DS is places on the layout, the inner track pieces are selected first (the selection box surrounds the inner 
tracks). In this state, the DS can be moved and rotated, but it cannot be connected to another piece of track (snapped),
as you are dealing with the inner tracks, which are internally connected to the outer tracks.

To connect a double slip switch to another piece of track, left-click an empty area of the layout not far from the DS, 
but outside of the selection box, to first deselect the inner piece of track. Then select one of the yellow outer track 
pieces that form the four ends of the DS. If you now click and hold the left mouse button and [Shift] key and 
approach another track, the DS will first be automatically rotated and, when you release the left mouse button, connec-
ted (docked) to the track. Of course, you can also connect multiple DS's together and integrate them into existing 
rail networks.

End tracks:
The group of track modules
ends with end tracks. End
tracks finish with a buffer stop,
which prevents more tracks
from being added. A buffer
stop knocks back rolling stock
as they approach the buffers. 
End tracks are marked as such
in the layout plan with a cross-
bar to distinguish them from
other tracks and to mark them
as the end of the stretch of
track. End tracks are laid just
like other tracks, only this time
click on the buffer stop button
to place an end track with a
buffer stop in the layout plan. 

Laying tracks in the 3D editor for routes: 
The 3D object editor isn't only used for landscape elements and structures, but you can also use the 3D mode to 
insert and edit tracks and other routes. This is generally intuitive, but should still be explained briefly. 

After switching to the 3D object editor in the control dialogue and selecting a track segment, you can place it by 
clicking in the layout's 3D window. The green arrow indicates the start of the track, while the green dot shows the end
of the inserted segment. If you right-click the selected track, the object menu will open with the available editing
 functions. Once you select an option, animated arrows will appear indicating how the piece of track can be edited, i.e.
moved, scaled or rotated. If, for example, you would like to bend a track to lay a curve, move the mouse cursor to the
arrow or the dot marking the start or end of the track, and move it in the desired direction.

Endgleis in der 3D-Ansicht
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Dialog zur Platzierung von Gleisen im 3D-Fenster
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Furthermore, tracks can also be copied, connected and – if you hold the [Ctrl] key – raised or lowered via the 
object menu. For the latter, however, the Match object position height to surface option must be disabled in the Insert
menu.

Important: 
Unlike in the 2D editor, which has one button each for a switch point, a two-branch switch or an end
track with buffer stop, the 3D editor only shows normal track pieces. However, tracks that have already 
been laid can be converted into switches or end pieces with buffer stops via the object menu, and switches
and buffer stops can also be converted back into normal track segments.

Auto alignment of a copied track is optional:
An option (in the menu accessed by the right mouse button) has been implemented in EEP to automatically align 
a copied or connected track which can be turned on or off as required. Previously, all copied and newly connected 
tracks automatically assumed the orientation of the previous track they were connected to in the 3D editor, 
which can still be handled this way. However, depending on your construction needs, you can now also turn off this
behaviour via the menu accessed with the right mouse button, allowing for completely free editing and orientation
(height of the track end). Selecting the option again places a tick and activates Auto Alignment.

Automatisches Ausrichten
von Gleisen 
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4.6.2 Inserting track objects

Track objects or trackside objects are generally made up of one or more track segments connected to a structure. 
Bridges, stations and turntables, for example, are all listed under this umbrella term in the EEP model catalogue. 

Track objects mainly differ from normal tracks due to their static construction, which unavoidably means that the 
dimensions of the corresponding models cannot be changed, but that they can only be completely deleted. If, for
 example, you deleted a track segment from a two-track bridge, the entire bridge model will be deleted.

To install a track object, the corresponding route editor first
needs to be activated and the desired track style must be selected.
In this case, this is of course the track editor. Click on the model
 catalogue to view a list of the available track objects. Here you will
find the folder for the bridges, stations and turntables categories, as
well as a collective folder with all the other trackside objects.

Once you have chosen a model, you can place the track object in the planning window, like any other object. An 
exact positioning can be achieved in the object dialogue, which can be opened as usual by right-clicking on the selected
track object. If, for example, you want to make a bridge slope, enter the desired angle of rotation in the Rotation X field,
and the bridge will be given an uphill or downhill gradient. It is not possible to create slopes on track objects via the
height parameters in the editor field. As this input field is for tracks and not for trackside objects, the height values 
at the start and end are always the same.

Turntables and traversers:
Originally, turntables were round platforms with rails mounted on them that allow for a change of direction of 
rolling stock in a tight area. For newer, larger turntables that are also no longer turned manually, the cover of the
turntable pit, which gave it its name, has been dispensed with. When building a turntable, it is recommended to choose
a flat area of terrain with enough space for additional structures.

Beim Einsetzen von Brücken wird der ausgewählte
Gleisstil übernommen
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Choosing the right turntable

Depending on its construction, a turntable can have multiple track connections arranged around it and which can 
be connected to other tracks. It can, however, also be limited to a single turntable track, which the other track 
segments can be docked to with a rotating motion in the 3D window. Connections can be added either as tracks 
or as track objects – e.g. in the form of a roundhouse. Due to their importance, turntables have their own category 

Eingesetzte Drehscheibe in der 3D-Ansicht
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in the track objects catalogue, so the selection is relatively large. Once you have selected a turntable and placed 
it in the layout plan, a track with prepared connection points will appear there. Even at this stage, the turntable can 
be operated in the 3D view. In the case of models without prepared track connections, tracks can be arranged indi-
vidually in the 3D view (for example with radial clearances of 40° or 60°). To do this, all you have to do is click on the
turntable and wait until the desired position has been reached. Then switch back to 2D view to connect the connec-
ting tracks to the turntable track. Repeat this process until the track connections are complete.

Turntables can only be moved in the 3D view! A simple left-click on the turntable platform is enough to set it in 
motion and to rotate it until it reaches its next connection point. As with their real-life counterparts, there are also 
turntables in EEP with different angular dimensions, such as 7.5°, 10°, 15° and even 20°. Please note that not every model
of locomotive shed can be attached to every turntable – exactly because of the different angular dimensions. 
When choosing a shed, the first criterion is generally the length of the turntable – depending on which locomotives are
to be handled by the turntable. Once the turntable model is in place, suitable engine shed models can be selected. 
When doing so, it is advisable to take note of the construction abbreviation. For example, 'Turntable 26m 15°_DK1' can
be docked directly with the models 'Roundhouse 1tr-15°_left wall_DK1', 'Roundhouse 1tr-15°_no walls_DK1' 
and 'Roundhouse 1tr-15°_right wall_DK1'.  The 'Turntable 26m 15°_DK1' model is a turntable without prepared 
track connections. This means you will need to switch to the 3D window after each connection to a track segment or
trackside object (roundhouse), to turn the turntable to the next pre-defined angle before more track objects can be
docked in the 2D window.

Attention:
For newer models, the constructor’s initials are found at the end of the name.

Traversers:
Similar to turntables, traversers are also set to allow rolling stock to quickly change position in tight areas. The 
change of position here refers to connected parallel tracks. It is especially recommended to use a traverser for engine
sheds or maintenance buildings that lie parallel to the main track. 

In EEP, a traverser consists of a mobile track laid between rails arranged in parallel. The mobile track, which is embedded
on a moveable platform, is moved along a sink to connect the track arranged on the opposite side. Traversers, which can
be found in the relevant category, are placed like any other track object. Parallel tracks can be connected to the mobile
track of the traverser as entryways and exits, as can trackside object, such as engine sheds. The mobile track is placed in
the 3D view, as the traverser can only be operated in this view. Once the mobile track has reach its new position, you can
switch back to the 2D view to dock further track segments.

In order to move a locomotive or other rolling stock to a parallel track, the locomotive must first be driven onto 
the traverser. Once the locomotive is in the correct position, you can click on the mobile track of the traverser to initiate
the movement to the next position. 
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As with turntables, traversers can only be set in motion in the 3D view! Once again, hold the [Shift] key to move the tra-
verser in a continuous motion, with the platform stopping automatically on the outer left or right side. You can stop the
movement by clicking on the mobile track again, or change the direction by clicking whilst pressing the [Ctrl] key.

4.6.3 Automated road traffic crossings  

Build your road traffic in
EEP 13 Expert with simple
means. This version of the
programme introduces
two new road styles, as
well as ready-made, fully
automated crossings and
branches. No further con-
trol elements or contacts
are required to operate
them. EEP 13 takes full
control of the crossings
and branches for you.

Eingesetzte Schiebebühne in der
3D-Ansicht
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4.6.4. Advanced copying of routes 

From programme version EEP 13 Expert onwards, the copying of routes from
another area is possible. Thus, for example, you can build a road next to a track
you have laid at a click of the mouse. Choose the desired style in the editor and
it will then be available for immediate selection.

4.6.5 Tracks and landscape

Generally, the track you lay adapts to the level of the layout surface. The standard track always lies at a relative height
of 0.60 m above the ground. You can create a climb or fall using slopes. If a slope rises from 1 to 3 m, for example, the
track will adapt to this climb so that the track height of 1.60 m at the start rises to 3.60 m at the end.

To move a track that has to be selected to a different
level above or below the landscape surface, the
height parameters need to be adjusted in the input
field provided for this purpose. There is a difference
between the absolute and relative heights here. 
The absolute height refers to the height of a model
(track) in relation to the original, unchanged layout
surface (in the real world, the height above sea level
– normally zero). The relative height is the height
 different between the model (track) and the land-
scape surface.

If, for example, a track is to be laid on a plateau 5 m
above the layout surface, the absolute height is 
5.60 m, while the relative height, i.e. the height of the
track above the visible, elevated layout surface
remains constant at 0.60 m. If the track runs horizon-
tally, the height value at the start and end will remain
the same. If, however, the track climbs, the values will
change. By entering different values at the start and
end of the track, you can lay tracks with a tilt for
entries and exits. The angle of the climb depends on
the length of the track and the height difference
between the start and end of the track.

Höhenanpassung des Gleises in der 2D-Ansicht
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You can also modify the pre-defined track height in order to lay tracks at a lower level from the start. If, for example, 
you reduce the relative track height by 0.30 m from the default 0.60 m, you can lay tracks at a height of 0.30 m. 
This may spare you the later adjustment of some EEP stations.

You can customise the default setting for the track height when no piece of track, road or waterway is selected. 
Only one field in the input for the height parameters is active, where you can now enter the desired height 
difference. If you then lay a new track, road, etc., the custom height setting will be used so tracks can now be laid 
higher or lower than originally.

The custom track height is also applied to saved track blocks – provided the 'Match object position height to 
surface' option is switched off in the Insert menu. You can also assign a custom track height to track combinations. 
In doing so, however, you should take into account that objects are automatically laid at a height of 0.0 m when the
'Match object position height to surface' option is switched off. This is due to the fact that there are many splines 
with different standard heights, which first need to be reset to the height of 0.0 m to guarantee the functioning 
of roads, waterways and tram tracks. So, if you would like to lay a track combination such as a parallel connection 
with the 'Dark track' style at a height of 0.30 m, the 'Match object position height to surface' option should first be
 deactivated and a relative height of (+) 0.30 m needs to be entered as the function of the track combinations 
lowers all track styles to the same level of 0.0 m.

Using the so-called alignment factor, you can now determine how deeply each track module should be embedded 
into the layout surface (if you are adjusting the landscape surface to the track). The alignment factor (shown in
 centimetres) can be custom set in a range from -10 m to +10 m. This makes a later adjustment of the landscape surface
in the 3D terrain editor unnecessary. The alignment of the embedding height usually takes place afterwards, i.e. after 
a track module has been laid and the landscape surface is adjusted to the track height.

Mit dem Abgleichfaktor kann die Einbettung in den Untergrund verändert werden
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Building railway embankments:
Generally, tracks adapt to the level of the landscape surface. However, there is also the option to adapt the land-
scape surface to the track height instead. This is recommended when creating embankments. Click on the button 
to adapt the landscape to the height co-ordinates of the tracks. By activating this adjustment function, the land-
scape directly beneath the selected track will be adapted to the height of the track. 

If the track lies above the surface, an embankment will be automatically raised. If the selected piece of track lies below
the surface, a trench will be automatically created that adapts to the height differences of the track. As a newly docked
track automatically assumes the height of the adjacent track, smooth ramps are created this way without having to
form them. Conversely, to adapt a track to the landscape, you have to enter the relative height at the start or end 
of the track and add the height of the embankment to it. Height difference in the 2D view and the 3D image. The bend
is missing here, of course.

Attention: 
Decisive for the possible width of slopes and their appearance is the number of grid nodes you set before
you start building a new layout.

The step-by-step process of building an embankment is demonstrated in the following example:

• Lay a track with a relative height of 0.60 m at its start and end.

• Connect another track to it and now set a height value of 1.60 m at the end of the track. The track will now climb.

• Then attach three further tracks that automatically adopt the same inclination using the duplication function. 
The final track now ends at a height of 4.60 m.

• Now select the individual rising tracks one after the other, and each time click on the button to activate the
Alignment function and to adapt the landscape surface to the height of the track.

Bildunterschrift  ????????
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There are also styles of track that already come with an embankment, e.g. 'Gleis1435_Bahndamm_...'.

4.6.6 Agriculture

This is new to EEP. To use this feature, you require various elements. On the one hand, this includes the actual fields which
can be found in the track objects of the Roads insertion mode, and on the other hand, the relevant vehicles which are
sorted into the Street – Agricultural vehicles category of rolling stock.

Steigung in der 3D-Ansicht (noch ohne Böschung oder Stützpfeiler)
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A field always consists of at least three components. These are
the actual field and the overflows. It can also be placed pre-
cisely via the corresponding dialogue. Once you have placed
all the components in your layout, you can turn to inserting
vehicles. For this, switch to the corresponding editor and
choose a vehicle. Now when you drive over your newly created
field with your tractor or combine harvester, your field will be
worked automatically, so it is not necessary to set individual
contact points for these functions.

Once the entire field has been worked, you can repeat
the process if desired. To do so, proceed as follows: Select
the field and then click the right mouse button. You can
now use the slider to change the setting. 

Modellauswahl für animierte Felder

Positionierungsdialog für Felder

Das  neue  Features in der 3D-Ansicht: 

Kontaktpunktdialog für Felder
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You can also manipulate the 'growth rate'. This value specifies the time it takes for a field to return to its original 
state after being worked. This time is set to 180 seconds by default. You can change this time as you wish. You can 
also control the growth via a structure contact, of course. Please refer to the corresponding chapter of this manual for
instructions on how to set a contact.

4.6.7 Animated water effects and floating objects 

This new feature allows for some impressive sceneries involving rivers and lakes. The following options are available:

•   Impressive wave animation on water surfaces 
• Adjustable environmental reflections on the water surface 
• Realistic behaviour of objects floating in the water 
• Adjustable visible water depths (cloudiness) 

Additionally, a new spline, new landscape elements and new structures have made their way into EEP.

Adjusting the height values of new splines
As you can see in the following image, setting the height values of the new splines is not done directly on the models
themselves, but in 'layout information'.
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Setting the floating behaviour of rolling stock
If you would like to adjust the behaviour of your rolling stock on the spline, please go to the model's properties.
Here you will find the 'Swim factor' input field. A value of 0 allows your model to glide over the spline without 
any rolling movement. A value of 100, on the other hand, has your model bobbing on the waves. Please adjust these
 values individually.

Setting the floating behaviour of structures/landscape 
elements
The same applies if you would like to adjust the floating behaviour
of your structures or landscape elements on the spline. Please 
open the object’s properties in this case. As with rolling stock, you
will find a 'Swim factor' input field. A value of 0 makes your model
lie motionless in the water. A value of 100, on the other hand, 
has your model bobbing on the waves. Please adjust these values
individually.
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Reflection settings
You can set the radius for reflections in the programme settings. To demonstrate the difference, we have provided 
two images below.

            Reflections in a radius of 500 metres

            Reflections in a radius of 0 metres
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Setting the visible depth of water
You can specify the depth to which your water should appear transparent in the model's properties. The following 
images illustrate this effect.

Visible depth up to 20 metres

Visible depth up to 2 metres
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You can see the difference. In the first image, you can see right to the bottom of the lake. In the second image, 
you cannot.

To round it all off, we have also included the 'Wasser Demo' layout which shows you the features 
and the individual models once again in detail.

4.6.8 Other track layers

Beside the track systems for rail traffic, there are also roads, tram tracks, airways and waterways. As these traffic routes
are handled just like tracks, you can also incorporate road, tram, water and/or air traffic into your transport system. 
The styles of transport systems can be combined together so that the outer appearance of the track system and the
 ballast bed can be changed section by section. A combination of different route systems, however, is not possible as 
they are fundamentally edited independently of each other. Each route system has its own editor in the planning
 window.

Track modules can now be exchanged within a track system – taking into account the signals and contacts.

• Open the respective track editor (tracks, tram tracks, roads, waterways) and activate the 3D editor,
• select the track style that should be applied to the module you are changing,
• right-click on the track module you are changing to open its object menu,
• click on the command in the object menu that changes the track style.

Austausch eines Gleisstils gegen einen anderen in der 3D-Ansicht
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Waterways and airways are invisible in 3D view and allow for the operation of vehicles that are not connected to a track
or road. This can be used to recreate air travel or maritime traffic on rivers and lakes. The invisible road style can be used
for road vehicles as it can be connected to the visible country road and city road styles. Thus, a lorry can drive on an
 invisible road located within a tarmacked industrial site and later join regular traffic on visible roads.

4.7 Omegas (animated characters)

The Omega feature adds moving characters to EEP. They can populate roads, squares and train station platforms 
and behave rationally. Everything can be adjusted: spawn location, whereabouts, despawn location, group size and
 composition, dispersal area, direction and intensity of movement. To set a group of omegas, click the corresponding
 button in the tab bar of the 2D view to open the Omega dialogue window.

New:
At the request of many EEP users, all the elements for controlling omegas are now also available in the 3D mode. 
This results in considerably greater clarity. The functions still have to be created in the 2D mode, but the fine-tuning can
be done in the 3D window. In this way, you see the results of the change instantly. 

To help clarify how to deal with omegas, we have created various example sce-
narios (as layouts) in the 'Tutorials' folder. These are:

•  Tutorial_24_Omegas.anl3
•  Tutorial_25_Omegas_2.anl3
•  Tutorial_41_Omegas_3.anl3
•  Tutorial_42_Omegas_4.anl3

You will find further information in a short introductory video at
www.eep11.com/tutorials 
This shows the basic functions.

Werkzeugdialog zum Einsetzen von Omegas (animierten Figuren)

1 2

3 4

5 6

7 8

9 10

11 12

13 14

15
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With the button in the top-left (1), you can insert a crowd into your layout. After pressing this button,
click on the area in the plan where you would like to place the omegas. A symbol with a grid structure

with arrows and circles will appear in the plan. These symbols will be explained in greater detail later as they contain
several sensitive areas that open dialogue boxes for fine tuning. Once it has been inserted, the crowd will appear in the
white box (red, yellow, blue crowd, etc.).

If you would like to remove a crowd, select the crowd in this box and press the delete button (2). 

You can now add additional sources (3) for an existing crowd and even sinks (4) –
areas where omegas disappear again.

Points of attraction (5) can also be placed, or points that omegas avoid (6). With the
buttons labelled 7 and 8, you can create fields in the plan which generally or partially
limit omegas' direction of movement.

A delay in the movement intensity can also be achieved (9 and 10). Use walls to block
off certain areas of the layout to omegas, which are generally impermeable (11) or
only impermeable to adjustable dimensions (12).

Omegas normally move directly on the layout surface. To make platforms 
and stairs accessible to them too, plateaus can be placed. These can be un-

limited (13) or limited in their dimensions in relation to the freedom of movement of the omegas (14). Finally, 
at the very bottom of the omega dialogue box, there is the function that encloses the area in which the crowd 
should remain, like a cage. If you hover the mouse pointer over the individual tool buttons, its function will be dis-
played after a short time.

Once a crowd has been placed in the layout (press button and left-click in the plan), the individual
influencing tools will become active (2 to 15).  Before setting up special intentions and limitations,
you can set the composition of the crowd, their exact spawn and the extent to which they spread out.

Good to know:
All control objects for omegas inserted into the plan can be selected by right-clicking them. They can 
then be scaled, moved and rotated using the symbols shown. A right-click opens the dialogue box. 
The symbols concerning omegas are only visible if the Omega tab is selected.
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Sources

Omega Source dialogue: The omegas are created here

This dialogue opens when you right-click within the area of the omega symbols. The height values are of parti-
cular importance if you want to simulate omegas exiting trains that have just arrived. To open the dialogue window
shown above, first left-click in the centre of the crowd symbols in the planning window, and then right-click within 
the white marking. If you perform the left-right click combination, you will open two other dialogue windows with 
input options.

The Source dialogue in the 3D view
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Crowds
This dialogue opens when you right-click the outer area of the omega symbols. The middle setting concerns the 
basic type of movement the crowd performs and at the same time corresponds to the Delay dialogue box (9, 10) or the
generation of fields for the movement intention.

Sinks
This dialogue opens when you right-click the outer area of the omega symbols. The outer circle with the directio-
nal arrows, on the other hand, represents the invisible limits. Once an omega oversteps this boundary, it disappears. 

The dimensions of 
this area, in which the
omegas can roam, can
be set via the radius.

Massen-Dialog: 
Hier kann die Popula-
tion festgelegt werden

Senken-Dialog: 
Hier verschwinden die 
Omegas wieder 
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If you want the omegas to leave the layout at one or several locations, these neuralgic points should be 
marked by  so-called sinks (4). If, on the other hand, omegas are to be generated at other points, additional sources 
should be set up (3). All the influencing elements can be moved as desired, even those shown when inserting the 
crowd.

Attractors and repulsors
These are elements that draw in or repel omegas. An attractor is a type of magnet that attracts EEP characters.  It can,
for example, be placed behind a door through which you want omegas to enter a building. Combined with a sink, the
omegas disappear at this point.

Attractor in the 3D view

A repulsor has the opposite effect. It repels omegas. With its help, you can protect objects that omegas shouldn't walk
through, for example.

Repulsor in the 3D view
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Simply place the repulsor over the element you wish to protect and your characters will immediately avoid it and 
try to go around it.

Fields
In the context of omegas, fields represent energy fields that act on the characters and set them in motion. They can 
be created as constant fields of action or as limited fields with a local effect.

Delays
The Delay option refers to the movement dynamic of the omegas, i.e. the speed at which they move. The lower you set
the delay, the faster the characters move.

Ein begrenztes Feld in der 2D-Ansicht

Ein begrenztes Feld in der 3D-Ansicht

Verzögerungsmodus in der 3D-Ansicht
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Walls

Walls (11 and 12) are important tools for controlling
omegas. These can be passed through from one side 
only (note arrow). While unlimited walls (11) stretch to
the edge of the layout, a limited wall (12) can vary in its
dimensions. Thus, you can use them to ensure that
omegas pass through certain entrances or passages.
Once again, the exact position and rotation can be set in
the object’s properties menu.

Limited wall in the 3D view

Platforms
Slightly more demanding is the placement of plateaus and ramps (13 and 14). A plateau doesn't only need to be ad-
justed to the desired height in order to make platform models accessible to omegas, for example, the crowd also 
needs to be brought to the right height. If you would like omegas to spawn at the height of the platform, for 
example, to come out of a lift, the insertion height needs to be entered at the source via the dialogue box. With a

Bei begrenzten Mauern lassen sich die Dimensionen 
exakt eintragen
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 continuous plateau (13) omegas cannot fall over 
the edge, which they could with a limited one
(14). It is therefore always recommended to block
off areas that omegas shouldn't enter using walls.
Cages (15) can also keep omegas in check.

Limited platform in the 3D view

Attention: 
Bear in mind that omegas will also need to be able to reach the area above a plateau in order to move
around on it. Either the source needs to be located above it or a slope needs to be built.

If omegas should not only more around on an elevated plateau, but also use a slope or even steps, limited plateaus 
must be placed on the respective models. The tops of models (steps, slopes) and plateaus should be covered by 
moving and scaling. You estimate the average height (e.g. at the middle of the slope) and enter the value under 
Height in the dialogue box of the plateau. Now you estimate the angle of the climb and enter it into the Inclination
box. Of course, you can calculate these values exactly using trigonometric formula. Bear in mind that plateaus are 
only impenetrable for omegas from above.

Dialog zur Positionierung einer begrenzten Plattform
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Cages

Cage in the 3D view

Cages, which also keep omegas in check, are another part of the animated characters content. You can trap your 
characters, with these elements. The omegas can be released by placing a contact. In this way, characters can be stopped
at traffic lights and continue walking when the signal comes.

Good to know:
All control objects for omegas inserted into the plan can be selected by right-clicking them. They can then
be scaled, moved and rotated using the symbols shown. A right-click opens the dialogue box. The symbols
concerning omegas are only visible if the Omega tab is selected.

Tip: 
If you want the omegas to walk instead of running, you need to set a delay.

4.8 Backgrounds  

To give you even more options when designing your layout, we have developed a new type of backdrop element. 
These are models that you can not only place within your layout’s boundaries, but also in the area beyond.

We already supply a large number of models for this purpose. Take a look at the following images and be inspired 
by the new possibilities. You can, of course, scale these backgrounds and place them at varying distances. This will 
give your layout an impressive sense of depth.
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There are two different ver-
sions of each background
model available. One flat
background, and one curved
version. You can choose
between them depending on
their application.

You will find the new backgrounds in the following area: Landscape elements – Terra – Hills

4.9. New sky effects (vapour trails and rainbows) 

Two new elements have been
added to the programme to make
the sky look a touch more realistic:
vapour trails and rainbows.

The optimum conditions for a rain-
bow are:

•   Clouds – maximum 50%
•   Rain – maximum 14%

Vapour trails are set in the Environ-
ment settings dialogue box by
placing or removing a tick in the
corresponding box.
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5. Putting layouts into operation

After modelling the landscape and setting up a track system for rail travel, the layout is surely far from finished, but 
ready for a first test run.

While your field of action has thus far been the layout plan in the 2D window, you will now move almost 
exclusively in the 3D window. In this window, your railway landscape not only appears in realistic 3D, but also 
develops vitality and dynamism. In the 3D window, you can go on a journey of discovery, insert vehicles, build
train consists, follow and control rail operations – in short, here you will experience an EEP world full of life and 

activity.

However, before we turn to operations, 
we should make, check and change some
settings that affect the appearance of the
landscape, amongst other things. Open 
the Layout Information option from the
File menu.

Wenn es die Leistungsstärke Ihres Rechners
erlaubt, sollten die Punkte Terrain LOD und
Terrainkachelung reduzieren deaktiviert sein
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You will find useful information about the layout's status and can create a description text which is shown when you
open the layout, as well as under System overview (top button of the tab bar) in the 2D window. You also define some
parameters for the operation of your layout here. In addition to switching to left-hand traffic, you can choose if electric
locomotives will require electrified tracks to operate. 

5.1 Inserting and placing rolling stock

Your layout has been created and the tracks have been laid, and now it is time to insert rolling stock. This is done in the
3D window using the Control dialogue. This is the control centre for everything that happens in 3D mode – the camera,
the terrain edition which only becomes active in 3D mode, and last but not least rail operations, of course.

Rail operations can only be started when at least one track has been laid upon which rolling stock can be placed. Similarly,
traffic can only start to roll once the rolling stock on the track has its own engine. 

Placing rolling stock
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Switch to the 3D window and open the control centre. To select a locomotive or later another vehicle, click on the button
in the control dialogue. This will switch you to the mode in which rolling stock can be inserted and placed. When this
mode is active, the vehicle catalogue opens: The middle section shows the categories and their folders, the models are
listed to the left of that, and the selected model appears in the preview window on the right.

Selecting rolling stock

To select a locomotive, click the category Rolling stock, then the Railway folder, track gauge and finally Locomotives
where you can now make your selection. When you click an item in the list, inspect the model from all viewing angles
using the preview window. Once you have chosen a model, switch to the overview window where the mouse cursor will
now turn into a mini locomotive, and click on the track where you want to place the rolling stock. A dialogue will then
appear allowing you to give the model a unique and easy-to-identify name.

Vor dem Einsetzen des
Rollmaterials können
Sie einen individuellen
Namen vergeben.
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Under Properties, you will find some texture replacement options.

There are many models available in EEP 13 that can be equipped with one or up to three exchange textures. In cases
where two or even three exchange textures can be selected, a 2 or a 3 is added to the name. The models specially
designed for exchange purposes can be identified by the blue text in the selection menu. To perform a texture replace-
ment, right-click the relevant model in the list box and choose the Properties option.

Click on the Load custom texture button to open the file selection dialogue, where you can select directory levels and
the exchange texture file type. Graphics in TGA, PNG, BMP or JPG format can be used as exchange textures, which can first
be edited in an image-editing programme of your choice, if desired. The formats *.tga and *.png are preferred as they
have an alpha channel, which allows transparent texture content to be implemented. EEP will automatically convert the
original format into the *.dds DirectX graphics format. During the conversion, MIP map levels are generated and a
suitable texture compression algorithm (DXT5 or DXT3) is used. 

Various locomotives and carriages equipped with interior fittings promise a special travel experience. Enjoy a 
journey of discovery through your layout in a driver's cab recreated in three dimensions, or make yourself comfortable
in a passenger carriage and experience your model rail landscape from the inside of a moving train. Such views can 
be achieved if you choose a functional model and select the appropriate on-board camera with the number 
keys [8] or [0].
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As multiple rolling stock of the same type – such as wagons or carriages – are often inserted, but their names can
only be used once, reference numbers are automatically added to the names of duplicates. If a track is already occu-
pied, you should select another section of track for your locomotive or wagon, or move the vehicle that is  already 
there.

Locomotives and wagons can be moved easily with the mouse:

• Point the mouse at the rolling stock you wish to move.
• Once the mouse cursor is located over the rolling stock and changes to a hand with an outstretched index finger, press

the mouse button and [Ctrl] key at the same time and drag the vehicle along the track.

• In this way, you can easily move locomotives and wagons to sidings, freeing up occupied tracks for other rolling stock.
• Rolling stock placed on a track automatically assumes the orientation of the track. However, sometimes it is -

necessary to rotate a vehicle and change the direction of travel. This can also be achieved easily:

–    Click on the vehicle you wish to rotate in the 3D view.
–    Click on the Place models button in the control dialogue. This activates the mode in which rolling stock 

    can be placed, rotated and removed.
–   Now click on the Turn vehicle or train in opposite direction button, which is only available in this mode 
      and which triggers the desired rotation.

Attention:  
Firstly, rolling stock should only be rotated if not coupled with other rolling stock, otherwise the entire train
consist will be turned around. Secondly, there should be sufficient space to avoid collisions or unwanted cou-
pling with other rolling stock.

Rolling stock can also be deleted just as easily as turned around in the 3D view:
• Click to select the rolling stock you would like to delete – this can be done in the selection menu and overview wind-

ow as well as in the 3D view.
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• Then click on the Remove train from layout button in the control dialogue to take the listed train consist off 
the tracks. This button is also only visible in 3D edit mode. Like with changing the direction of travel, rolling 
stock you wish to remove should not be coupled with other rolling stock otherwise the entire train consist will
disappear.

Model replacement function for all model types
By popular demand from EEP users, a replacement function for models in all layers has been implemented, allo-
wing not only track styles, but rather all model types – e.g. structures, landscape objects, rolling stock, signals, etc. –
found in the same layer to be replaced in the 3D editor. To replace a model, first select the model you wish to insert 
from the model list (using the left mouse button), and then click on the model you wish to replace in the 3D window of
the editor. The selection of the model you wish to replace will be indicated with constant flashing.

The actual replacement is now completed by right-clicking the model and selecting the Replace command from the
menu. When replacing a wagon within a coupled train composition, different lengths are taken into account and the
entire train composition is shortened or extended to the optimum length.

Important note:
Models can only be replaced within the same layer. 

Tausch des Modells gegen das Modell in der Auswahlliste
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5.2 Controlling rolling stock

The locomotive you have just placed on the tracks now needs to be set in motion. The instruments for controlling train
operations appear when you click on the next button down and switch from editing mode to vehicle control. Once 
the button has been activated, the model catalogue will disappear to make way for the control panel. All traffic operations
on tracks, rails and roads, and on invisible air and waterways are controlled via this panel.

EEP differentiates between two types of vehicle control: manual and automatic control. In manual mode, you can control
each rolling stock yourself.

Attention: 
In this mode, rolling stock will react neither to pre-set contacts nor signals! In automatic mode, however, 
all traffic runs dependent on signals, without you being able to intervene to control the process. The vehicles
are remote controlled as per the direction and times you have specified in the timetable.

The operation button switches between the vehicle and train speed modes.

You can toggle operating modes using the vehicle control panel. To do so, click on the button that now becomes a toggle
switch to turn manual or automatic control on or off.

5.2.1 Manual control

For manual control, the following keyboard commands (hotkeys) are available in EEP, which above all facilitate manual
manoeuvring.

Im Steuerdialog 
können Sie zwischen der
Fahrzeug- und der Zug -
geschwindigkeits-
einstellung wählen.
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=    Drive backwards

=   Drive forwards

=  Stop / Brake (Pressing this button engages the brakes of the selected vehicle)

=  Train brake (During manual control, you can turn on or off the brakes for the entire train with this 
button – press several times if necessary)

=    Horn / Bell / Warning signal

=    State of rear coupler (Affect the state of the rear coupler and alternate it 
by pressing the button repeatedly)

=   State of front coupler (Affect and change the state of the front coupler)

=   Position of a switch (Control the next switch – within a distance of up to 500 m –
by pressing the key; multiple times if necessary)

=   Position of signals (Change the aspect of the next main signal within a distance 
of up to 500 m. Multi-aspect signals are switched by repeatedly pressing the G key)

Hotkeys for controlling rolling stock
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5.2.2 Gamepad controls

EEP 13 allows you the comfort of controlling your rolling
stock with a gamepad. If you would like to use a gamepad,
please first select it in the EEP programme settings.

Gamepad controls are the same no matter which model
you use, even if, for example, the left stick is located above
the D-pad, like on an Xbox controller, or below it, like on a
PlayStation controller.

Important note:
If you would like to swap the functions of the
two analogue sticks, please place a tick in the
highlighted box. 

The gamepad controls are arranged as follows:

Zug

Weiche

Schultertaste unten: 
Fahrstufe verringern

Schultertaste oben: 
Kupplung hinten

Schultertaste unten: 
Fahrstufe erhöhen

Schultertaste oben: 
Kupplung vorne

Signal

Notbremse

Kamera
drehen

Kamera 
Perspektive

Kamera
positionieren

Mitfahr-
Kamera

Pause
an / aus

Waggon
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The individual control elements of the control perform the following functions.

Right stick
If the on-board camera is switched on, you can move towards or away from the 
vehicle using the right stick. Otherwise, you can use the right stick to move around your
layout.

D-pad
The D-pad has two functions:
the vertical axis selects a train consist; the horizontal axis allows you to move from 
one carriage to the next within the selected train composition.

View button
The view button switches a rolling stock's on-board camera on and off. 

Menu button
The menu button pauses and unpauses EEP.

Left stick
If the on-board camera is switched on, you can circle around the vehicle using the left
stick. Otherwise, the left stick will rotate the camera around its own axis.

A button
The A button is the system's emergency brake, so to speak. Press it to set the speed of the
currently selected rolling stock to zero.

B button
The B button changes the aspect of the next main signal within a distance of up to 500
m. Multi-aspect signals are switched by repeatedly pressing the B button.

X button
The X button steps though the camera positions when viewing a model, according to
camera positions 1–9.
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Y button
The Y button controls the next switch – within a distance of up to 500 m – by pressing
the key multiple times if necessary.

Shoulder buttons

Triggers
The triggers control the accelerator. The more you push the triggers, the faster the speed
changes. 

Bumpers
The bumpers are used for coupling. You can select the carriage or wagon in a train 
composition using the D-pad whose coupling you wish to engage or disengage.

On-board camera

a. On
If the on-board camera is switched on, you can circle around the rolling stock using the
left stick. You can zoom in to or out of the rolling stock using the right stick.

b. Off
If the on-board camera is switched off, you can rotate the camera using the left stick, 
and move around the layout using the right stick.

Note
Switching on the individual functions of the controller does not affect the type of control of a train
(manual – automatic).

5.2.3 Manual control

When manual control is switched on, you have supreme authority over your rolling stock. Even if a locomotive in automatic
mode is standing at a stop signal, if it is started in manual mode, it will move in spite of the 'stop' signal.

To set a locomotive in motion on the tracks, you must first select it in the vehicle list in the control panel or click on it
in the 3D view. It is faster, however, if you assign a hotkey to your locomotives and wagons on the tracks via the key-

board shortcut list. Instead of searching for a locomotive with the less than catchy name DB E10 299 bl;002, for 
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example, simply press the selected key combination and the camera will jump to the locomotive you're looking 
for and will immediately switch to the linked camera mode.

The locomotive is set in motion using the accelerator control which regulates the driving force and controls the 
speed. Analogue to this, you use the brake control to throttle the speed and brake the rolling stock. And 
finally, you use the control for the gears to set the direction of travel and to adjust the power transmission of 
the engine.

5.2.4 Automatic control

Automatic control of rail operations is only possible for rolling stock with their own engines. In automatic mode, rolling
stock is controlled via pre-set contacts and signals, without you being directly involved. You yourself only define the
 settings and leave the execution to the programme which controls the drive, speed and braking of the individual vehicles
along with the overall process.

Automatic control can be switched on in two ways – either by clicking on the toggle switch in vehicle control, or by
clicking on any rolling stock whilst holding the [Shift] key in the 3D window.

If automatic control is switched on, the control panel changes. While you can control a train's speed using the accelerator
and brake controls in manual control mode, you only set the target speed in automatic mode, and the programme
takes control.

To set your locomotive rolling in automatic mode, slide the control for the target speed to the desired position or 
set the speed by entering a value in kilometres per hour (km/h). The locomotive will then start up and hold the pre-set

Das Bild zeigt den
Geschwindigkeitsmodus
bei der Steuerung von
Rollmaterial
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speed for as long as the signals allow it. The programme compensates for fluctuations that result from the route 
through the use of gears, the accelerator and brake. The route the journey takes, where and when the locomotive
stops, continues and finally arrives at its destination is determined by the timetable you can create for each vehicle in the
traffic system. We will deal with this topic in the next chapter.

How can you stop a moving train in automatic mode? You can return the slider to the middle position. It is simpler,
however, to right-click on this slider. All sliders in EEP can be reset by right-clicking on them.

You can also assign certain routes to your trains in automatic mode. This topic is also part of the contents of the next
chapter and will be dealt with there.

5.2.5 Custom rolling stock camera

This feature has also been implemented due to strong user demand. The individual camera positions that can be defined
for each vehicle (rolling stock) are saved directly in the layout file.

To save a custom camera, a vehicle must first be selected in the 3D editor. While it is selected and flashing, you can 
set the camera position using the arrow keys, the [R] key and the space bar on your computer keyboard. Right-click
to open the menu and select the option Save Custom Camera. Camera settings you have defined and saved can be ac-

cessed via the [9] key
on the computer key-
board or via contacts.
The corresponding
entry in the Contacts
dialogue menu is Cus-
tom defined view.

Einstellung der Sicht 
der benutzerdefinierten
Kamera mit den Pfeil-
Tasten.
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5.2.6 Properties Explorer

The Properties Explorer is an additional programme to EEP 13, which you can use to change the driving properties of
all rolling stock in a simple way. This function is started via Extras -> Properties Explorer. 

The main window of the Properties Explorer

Here you see the programme's interface. On the left-hand side at the top, you see the rolling stock list as you 
already know it from EEP 13. In the window below that, you will find all the models in the selected category. In the 
top-centre section, you can see the complete path to your selected model. You will also see the current maximum 
speed there.

Good to know:
The maximum speed is calculated based on various parameters. Amongst other things, your computer's per-
formance and the frame rate are taken into account. Furthermore, the weather in EEP also plays a role.
Finally, it should be noted that slopes along a stretch also affect the speed. Consequently, the 'maximum
speed' calculated by the Properties Explorer cannot always be reproduced in EEP.

Now select the model for which you would like to define new driving properties. You will find a preview of this model in
the window on the right. In the middle section, you will now see the current parameters. All or only some tabs will now
be available, depending on the model. For models with motors and gears, all tabs will be active. If you have selected a
trailer, for example, only the 'Vehicle properties' tab will be active because a trailer, of course, has neither a motor nor
gears. You can set the individual values by moving the sliders. In doing so, any potential changes to the maximum speed
are shown.
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Once you have finished making changes to the settings, save the values. The changes apply immediately to this model
whenever you place it in one of your layouts. An already open layout which contains this model must be reloaded for the
changes to take effect. If you are not satisfied with the results of the changes, you can restore the original values at any
time. 

To do this, load the relevant model again in the Properties Explorer and click on the Read original values button. Don't
forget to save your changes when you are finished, otherwise the values will not be applied.

5.3 Assembling trains
Locomotives, carriages and wagons are equipped so that they can be coupled and assembled into a train consist. 
Coupling is basically done in the same way as with real model railways: a rolling stock is slowly driven or pushed towards
another one. If the couplers of both vehicles are engaged, they will automatically connect upon contact.

When a rolling stock is placed, the couplers at the front and rear are automatically active so that other rolling stock 
can couple. Coupling is controlled via the corresponding icons in the control dialogue which display and 
activate the current status:

Top: Rolling stock is connected to the coupler (front or rear). The display is active (grey selection
button) until the two rolling stock are separated.

Middle: The coupler is active when this button is illuminated. Another rolling stock can be con-
nected.

Bottom: The coupler is deactivated when this button is active. The coupled rolling stock has been
disconnected.

With EEP 13, it is now possible to couple locomotives and carriages 'gently', like their real-life counterparts. To do so,
please proceed as follows: First activate the 'Gentle coupling' option in the layout information. The reason for this is that
previous layouts purchased from the shop would not work if they have been built so that a coupling locomotive shunts
the carriages to the next contact.

Diese Symbole veranschaulichen die drei 
Kopplungszustände von Rollmaterialien
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If this function is activated, a locomotive will automatically slow down if:

• the couplers of the locomotive and carriage are 'engaged',
• the locomotive is travelling in automatic mode,
• the locomotive comes within a certain distance of the carriage.

We explain the possibilities of this feature in Tutorial 57 – gentle coupling.

Not only individual locomotives and
carriages can be coupled and uncou-
pled, but also entire train consists.
This allows typical operations such as
'portion working' and 'running
around' to be controlled automatical-
ly. You will find more on this in the
following chapter. Once you have as-
sembled a train, it is recommended
that you save it using the Save train
command in the File menu under its
own name so that the train can be
used again in other places or in other
layouts. In EEP, you can insert not only
individual locomotives and carriages,
but also coupled rolling stock and
even train consists in the 3D view –
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provided that the track segment in ques-
tion allows it. You can also remove not only
entire trains in 3D mode, but also individual
carriages without having to go to the trou-
ble of uncoupling the train composition.
Simply click to select the carriage you
would like to remove, and then click on the
Remove object command in the object
menu. To close the resulting gap in the
train, click on the preceding or following
carriage, select the Move object option in
the Object menu, and move the carriage far
enough forwards or backwards so that it can couple with the next carriage. Furthermore, trains' direction of travel can
also be changed in the 3D view: click on any carriage in the train composition and select the Turn vehicle or train in op-
posite direction option from the Object menu, and the entire train will be turned around.

5.4 Animated driver's cabins 

From EEP 10 onwards, you can actively
drive locomotives and railcars. For this,
you enter the 'cockpit' of the locomo-
tive, like in a train driving simulator, and
take the place of the train driver. Go to
the Camera section in the control dia-
logue in the 3D view and activate the
on-board camera.

If you now press the 8 or 0 key on your
keyboard, you will be transported im-
mediately to the driver's cabin, as long
as the selected locomotive has an ani-
mated cab.

The basic version of EEP contains ani-
mated driver's cabins for the following
locomotives:

          Im Auswahldialog finden Sie den 
          Punkt „Rollmaterial wenden“.

Kabine der BR 18-201
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•  BR 18-201                        •  DB 110                                          •  VT 11.5 TEE
•  ICE 3 BR 407                     •  BR 232 (Ludmilla)

You now have all the relevant control elements in front of you, which can be selected using the mouse pointer and put in
the desired place by moving the mouse. For ease of control, the individual elements have tooltips which are shown 
when the mouse hovers over the sensitive areas.

5.5 Vehicle physics for road vehicles 

In general, the handling of rolling stock depends on the vehicle properties that were taken into account during the 
construction of the true-to-life models. These properties include the net weight, drive, brake power and friction, which
are different for each rolling stock and the combination of which determine the vehicle's properties and handling. 
This applies to all vehicles that can be inserted in an EEP layout. All road vehicles lean into curves more or less depending
on the speed and the curve radius. They also lean forwards when braking and back when setting off. This new behaviour
is now an integral part of EEP.

Furthermore, there is also a whole range of models in EEP equipped with special features which also expand the
 functionality of your layout as a whole.

Kabinenansicht der BR 232 (Ludmilla)
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5.5.1 Fictitious forces in models

There are various models in EEP 13's model portfolio for which fictitious forces, such as centrifugal force, have been im-
plemented. The models constructed in accordance with the rules of Newton's axiom include helicopters and a mountain
cable car.

During operation, these models are characterised by the fact that they are subject to the force of gravity:
they sway to the side due to radial acceleration, and they swing back and forth when accelerating and braking due to
constraint force (mass inertia). In doing so – regardless of the rise or fall of the track – they remain constant in their 
inclination and stable in their horizontal operating position.

5.5.2 Vehicles with brake lights and signal lights

There is also a series of car models and trams with stop lights and indicators. These vehicles' stop lights turn on when
their brakes are in use or when they come to a standstill. 
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The flashing light function is active when a vehicle equipped with them is travelling along a route with a switch point.
The signal lights only indicate the turning direction on the section of track before the switch or crossing. Therefore, 
when building crossings, you should ensure that the switch points are long enough (e.g. 50 m) or that the speed of the
vehicles is reduced accordingly by contacts.

5.5.3 Vehicles with fire fighting water

Firefighting vehicles equipped with water cannons and fire fighting water also number amongst the vehicles with 
expanded functionality. The fire fighting water function is similar to the fire in structures function, which you are
already familiar with.

The water jet can be activated and controlled manually and automatically via vehicle contacts. The manual 
metering of the water pressure can be controlled via the axis selection menu and the accompanying slider. With auto-

matic control, several ve-
hicle contacts are usually
placed on the track,
which first control the po-
sition of the water can-
non and then the desired
water pressure. The con-
tacts for setting the mov-
able axes and the fire
water can be placed on all
types of traffic routes.
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5.5.4 Steam, smoke and acoustic signals

Even good old steam engines do not need to hide behind futuristic electric locomotives in EEP, at least not in terms 
of functionality. To increase its nostalgic charm, the steam has some extra special qualities. After all, not all steam is the
same. Thus, it is given off in different ways:

• from drainage valves
• from the jet pump when taking in water from the tender
• from boiler safety valves
• when operating a locomotive's whistle

For train consists with passenger carriages, steam 
heating can also be simulated – on the last carriage,
where the heating valve is always slightly open. With
the expansion of the steam options, accentuated by 
the characteristic hissing, the addition of a train whistle
was obvious. To sound off that unique rolling stock warn-
ing signal, you only have to press the [H] key. Whether
the horns of cars and lorries, the signal horns of electric
locomotives or the steam whistles of steam engines
sound depends on the type of rolling stock. In general,
however, all warning signals are either sounded manu-
ally using the [H] key or automatically via vehicle 
contacts.

It is also possible to assign individual sounds to mo-
torised rolling stock (locomotives, cars, trams, etc.). To do
so, proceed as follows: 

Choose the type of sound that should be made via the
'Sound mapping' button on the left side of the window.
The following options are supported: starting, brakes,
steam outlet, curves-slip noise, engine running, rolling
sound and warning signal (horn, bell, whistle). Select a
specific sound under the 'Load sound' button on the
right-hand side and assign it to your model.
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5.5.5. Loading feature for vehicles with movable axes

Whether a vehicle is equipped with movable
axes is shown in the list of moving parts in the
control bar which can be viewed by clicking on a
model in the 3D view. 

You can select the desired model here in the 'Vehicle' box. The 'Select axis' box will then update immediately and 
will now contain all the functional axes of the model. Select one of the axes and set the desired position using 
the 'Axis control' slider. Alternatively, you can also enter the value directly in the 'Position' field. If your axes are in 
the desired position and, for example, you would like to hang
goods on a crane hook, now press the Load button (in the
 corresponding dialogue box on the right). Your goods have now
created a connection with the crane. And you can now move
them.

The figure shows a crane wagon loading a crate. You can select
the axes controlling the jib and the hook from the list (if the
crane is activated) and move them using the slider. If, for exam-
ple, you direct the crane's hook towards the crate using the axis
control, you can pick up the goods with a click on the Hook but-
ton. The goods can also be released from the hook by another
click on this button.

You also have the option of saving different
axis settings of a model in groups.  To do
this, switch to the Insert dialogue and
right-click on the axis model. Now click
Save Axes Position in the dialogue window
that appears and save the current positions
in one of the groups. There are a total of 16
groups available. 

Speicherung der 
Achsenstellungen in Gruppe

Steuerdialog für die Achsensteuerung
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Once you have set up all the groups you require, you can run the animation by triggering contacts. The corresponding
 dialogue box is shown here.

Select the group of axis positions you'd like to run when the contact is activated via the Group settings drop-down 
menu. Each time the contact is activated, the desired movement of the model axes will be automatically triggered,

You will find further information about setting contacts in
Chapter 6.2.

To breathe more life into loading scenes, you can now add
animations that simulate the loading of coal, ballast, sand
and other bulk cargo that produces dust. The animations, sup-
ported by various structures and rolling stock, can be trig-
gered manually with the axis control slider or automatically
via contacts.

Einstellungsgruppen für die Achsenstellungen
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5.5.6. Other animation models

EEP also has a range of models with animated textures, such as advertising spaces, escalators and conveyor belts. 
While animated advertising pillars with changing adverts have been designed to move constantly, conveyor belts and
similar models can be switched on and off specifically using contacts.

5.6 Displaying text

You can make your home-made EEP 13 layouts available to other EEP users. 
To make exploring your new virtual world easier for them and to draw their attention to specific events, the automatic
display of texts has been incorporated into EEP. Texts can be displayed in two ways:

•  via mobile cameras saved with the layout with the text only being displayed when a mobile camera is active
•  via so-called information models, which allow text to be shown in specific locations
•  via tip texts for objects and contacts

5.6.1 Text display with mobile cameras

The settings for text display can be changed in the 3D editor by opening a mobile camera's properties dialogue window
and clicking on the Display information text button.
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The following text display parameter options are available:

Text alignment: justified, centred, left-aligned, right-aligned, scroll.

Text scaling: size of the characters from 0.50 (for half-size, i.e. 50%) to 2.0 (for double the size, i.e. 200%)
Scroll speed: the speed at which the text moves (only when the alignment has been set to scroll). The value is calcu-

lated by the width of the screen over time (0.2 means a scroll speed of 0.2 screen widths per second).
Text colour: opens another window with the colour selection for the text.
Duration: display duration of the text in seconds.
Repeat text: repetition of the text (only if scroll is enabled).
Do not interrupt: lock for displayed text when switching to another mobile camera with no text display. If this option

is enabled, the text will be displayed until the end of the pre-defined time, even when images from another mo-
bile camera are being shown.

Display text: enter the text you would like to display in the input box. A maximum of 1000 characters can be 
used.

5.6.2 Text display via so-called 'information models'

The information models can be found in the structures selection menu under: Structures > Control items > Information
models

Specially constructed
models with the ability to
display text in the 3D view
are sorted into this catego-
ry. This can be any type of
object; from a small direc-
tion sign by the roadside to
a signal box or a stately
cathedral. The advantage
of this display type is that
the text is shown depend-
ing on the location of the
model rather than the
camera. Consequently, this
text is displayed whenever
you enter the sphere of in-
fluence as defined in the
model’s properties. The
range of such models can
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be set between 10 m and 500 m, which can be done either in the model's Properties dialogue window by entering 
the value (in metres), or by dragging (shrinking/enlarging) the hatched circle symbolising the sphere of influence in the
2D planning window.

The following text display parameters are available in information models' properties dialogue window:

Text alignment: justified, centred, left-aligned, right-aligned, scroll.

Text scaling: size of the characters from 0.50 (for half-size, i.e. 50%) to 2.0 (for double the size, i.e. 200%)

Scroll speed: the speed at which the text moves (only when the alignment has been set to scroll). 
The value is calculated by the width of the screen over time (0.2 means a scroll speed of 0.2 screen 
widths per second).

Text colour: opens another window with the colour selection for the text.

Duration: display duration of the text in seconds.

Speech bubble: small speech bubbles appear above the model (similar to the principle of smoke signals), 
attracting the viewer's attention.

Display text: enter the text you would like to display in the input box. A maximum of 1000 characters 
can be used.

Edition des Aktionsradius der Informa-
tionsmodelle im 2D-Planfenster
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The display text can also be accessed by right-clicking in the 2D planning window.

An information model drawing attention to itself in 3D

5.6.3 Tip texts for objects and contacts

Another new feature in EEP 13 is that a tip text (a small speech bubble) can be assigned to any object or contact. 
The background colour for the text can be chosen freely from the colour palette. The text bubble appears above the 
object in 3D. Texts can be changed via the Lua function, and can be switched on and off. The corresponding Lua func-
tions are:

EEPShowInfoSignal(ID,_Status)                  turns the tip text for Signal ID on or off.
                                                                                   -- _Status true/false for on/off

EEPChangeInfoSignal(ID,"new text")        changes the text for Signal ID

Lua function for switches:                               EEPChangeInfoSwitch(ID,"text")
                                                                                   EEPShowInfoSwitch(ID,_Status) 

Lua function for structures and                    EEPChangeInfoStructure("Lua_Name","text")
landscape elements:                                          EEPShowInfoStructure("Lua_Name",_Status) 
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Important note
Contacts do not have IDs. Therefore, tip texts for contacts cannot be changed via Lua. Tip texts for contacts
are only visible in Edit mode.

You will find an example of
the use of tip texts in the 'Tu-
torial 57 - Gentle coupling'
layout.
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6. Signal control

Anything that happens automatically in an EEP layout is controlled via the signal system. Whether it's a camera pan, a
fire brigade deployment, automatic rail operations or the loading of goods, there's no getting around signal control. That
which has already been anticipated in previous chapters, but which has often only been hinted at, will now be dealt with
systematically in this chapter.

Signals are set to control rail operations and to automate traffic flows. They usually comprise a main signal and 
an approach signal and, due to their position, cause vehicles in automatic operating mode to stop or continue moving.
Thus, barriers and level crossing, which are not generally referred to as signals in normal speech, also fall into this
 category.

Just as traffic flows are regulated by signals, vehicles can also influence signal positions. All automated processes in an
EEP layout, whether relating to signals, switches, vehicles, structures, the camera or even specific soundscapes, are con-
trolled by contacts which can be set and defined in the signal control editor. Signal control is therefore actually the
control centre for all automatic processes in your layout.

Attention: In the Help menu, you'll find the entire 'Deutsche Bahn' signal book (in German) in PDF format
to download, study and print. It may be of help when you struggle with various acronyms in the signal’s
names!

6.1 Setting up signals

Controlling signals is done in the signal system
editor, which can be accessed via the list of edi-
tors in the 2D window. The signal editor manages
the model catalogue and is responsible for as-
signing contacts. The editor is divided as follows:
the buttons for the contact tools along with the
corresponding list box can be found between the
categories and folders at the top, and the models
at the bottom.

Die Kategorie wird per Doppelklick ausgewählt
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Placing signals:
Signals are selected and placed just like other models. If you select a signal using the preview, you can set the signal on
the desired section of track with a simple click of the mouse. As all signals are linked to tracks by their nature and purpose,
they can only be placed by the trackside.

Approach signals and main signals are denoted by two icons in the layout plan. The signal arm indicates the main signal,
whereas the approach signal is signified by a disk. Both symbols can be selected with the mouse in the layout plan and
in the overview window, and can be moved along the track by holding down the mouse button. If you drag the approach
signal beyond the main signal, both objects will be rotated through 180° and automatically placed on the other side of
the track which results in the signals applying to traffic travelling in the opposite direction.

To set a signal either in the planning window, overview window or 3D window, you only need to click on the signal whilst
holding the [Shift] key.

Signals are automatically set to the right of the track in the direction of travel. Since EEP 9, however, you can also set
signals against the direction of travel by clicking on the left half of the track in the 3D window to select the position.
This spares you having to then move the approach signal. In doing so, you should zoom the camera as close as possible
into the track in the 3D view so that you can differentiate between the left and right halves of the track. As with the
 position, you can also set the distance between the signal and the train stop position in the 3D view, whereas up until
now you had to decide the distance from the signal at which the train came to standstill in a relatively abstract manner
in the planning view. In the dialogue which can be opened via the object menu of the selected signal, you can set the
braking distance and also decide a start delay in seconds. The latter is useful at level crossings to hold cars back 
until the barrier is fully risen.

Signale in der 
2D- und 3D-Ansicht
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6.2 Setting contacts

6.2.1 Signal contacts

For a signal to be able to fulfil its function automatically, con-
tacts must be assigned to it. A contact is just as simple to place
as a signal:

• Activate the signal you would like to assign a contact to by clicking on it.
• Select the Signal contact from the 'Contact for' list in the signal editor and then click on the button 

(see top-right) that activates the contact tool.
• Now click on the section of track where you would like to set the contact in the layout plan.

As with the signal, you can also go back and move a contact that hasn't been placed properly.

Contacts can also be set and edited in the 3D view. To do so, first select the signal in question in the 3D editor, right-
click to open the object menu and then select the Set contact option. You can place the contact with another left-click 
on the track module's position.
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Contacts are quick to set. The configuration takes a little more consideration. This determines how and when the action
linked to the contact is triggered. The settings have to be set for each contact individually and are defined in the config-
uration menu, which can be opened by right-clicking on the active contact.

In the Signal contact configuration menu, you can set:

• the direction from which the train needs to come to trigger the contact

• when the contact responds
– on each passing train (or only with each 2nd, 3rd, etc.)
– the delay (in seconds)
– at the end of the train

• the vehicle/route that triggers the contact

• the state of another signal or switch (if signal/turnout #) as a mandatory condition for the contact 
to take effect.

• the effect, i.e. the position the signal should take when the contact is passed.

The contacts, which you can configure in
the menu, can be triggered according 
to your setting or even randomly, which
of course can provide some surprises.
To switch on the internal random gener-
ator responsible for this, you must set it
that no passing train triggers the con-
tact. Why? Because triggering the con-
tact should be left to chance. You can do
this by entering a zero (0) in the input
box.

Contact offset trigger spots:
By popular request from EEP users, the so-called 'Offset trigger spot' has been added to the Contacts dialogue window.
This is an additional distance (measured from the contact in metres) that the rolling stock need to cover before the actual
action of the contact is triggered.
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The If signal/turnout # function provides the possibility of
connecting contacts for controlling signals (and also switch-
es, vehicle, structures, sounds and camera) to the logical 'if'
condition according to the 'true' or 'false' criterion. That
means that action linked to the contact can only take place
if the condition is met. If the condition is not met, the contact
will not trigger the action.

Good to know: 
Please note that logical conditions can only be set for objects with an ID number. This includes all signals,
switches and all double and single slip switches whose sequential numbers are shown in the planning and
overview windows. You may omit the leading zeros when entering these IDs.

You now know the theory behind placing signals and controlling them via contacts. Practice will give you a concrete
grasp of how it works.

To gain some experience, first create a simple switch system:

• Lay a simple oval of track in the track editor.
• Switch to the signal system editor and select a signal to place at an appropriate position on the track in the layout

plan.
• Select the signal and choose the Signal contact from the 'Contact for' list in the signal editor.
• Now click on the button to activate the contact tool and place two contacts in the layout plan – one between the 

approach and main signals, and one after the main signal.

Die Aktivierungsdistanz bei Kontaktpunkten 
(hier für Fahrzeuge)
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The first step is now complete. In the second step, you can determine the actions you would like to link to the two
contacts: 

• First select the contact positioned between the approach and main signals.
• Now right-click on the selected contact to open the configuration menu.
• Select Direction one and enter the number 20 in the Delay operation and select the effect Clear. You can skip 

the remaining settings.

Configure the second contact behind the signal in a similar manner.
• Select Direction 1 again and then the option End of vehicle, and choose the effect Danger for the second 

contact.

That's it. If you now set the signal to Danger by clicking on it whilst holding the [Shift] key, the signal is ready to 
control.

What happens? When a train in automatic mode approaches the signal showing 'Danger' from the specified direction, it
will brake at the approach signal and come to a stop at the main signal. After the pre-set delay of 20 seconds, the signal
will switch to 'Clear' and the train will drive on. When the last carriage has passed the second contact, the signal will
switch back to 'Danger' until the next train approaches, and the process repeats. In this way, you can create an automated
stop at a station with two contacts. If you have experience of real model railways, you will recognise the similarities with
the implementation of this little control task.

Level crossings:
Like signals, level crossings can be controlled fully automatically via contacts. A level crossing in an EEP layout has two
barriers that need to be placed individually for each direction of travel. It is important that the level crossing is not placed
too close to the crossing point between the track and road, otherwise you risk the level crossing being placed on the track

Zwei Kontaktpunkte für Signal 001
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and not on the road. You can avoid this by moving the level crossing to the right place afterwards. For a level crossing, 
the approach signal of the second barrier or traffic lights must be moved beyond the main signal in order to secure
road traffic coming from the opposite direction.

The automatic control contacts need to be set and configured separately for both barriers and stop lights. The contacts
should only ever be active for one direction of travel. So a fully automatic, one-lane railway level crossing secured on 
both sides requires the eight contacts to be placed, ensuring that the barriers close when trains approach and open 
again once they've passed.

Track blocks:
The contact control mechanism also allows track blocks to be set up. These are track sections divided into several 
block segments. This division is to ensure that the individual sections of track can only ever be occupied by a single train.
This is realised using signals controlled by contacts. Imagine the process as follows:

When a train enters block B after passing through block A, it passes over a contact and switches signal A at the end of
block A to 'Danger', so that a following train cannot enter block B. As the first train now leaves block B and enters block
C, it passes over another contact for signal A. This contact sets signal A to 'Clear', while another contact switches signal B
to 'Danger', and so on and so forth. 
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By planning and constructing a carefully
thought-out signal system with track block
safety, collisions can be avoided.

6.2.2 Switch contacts

As with signals, switches can be controlled automatically using contacts. With the skilled combination of switch 
and signal control, rail traffic at terminal loops, track ladders, stations and virtual depots can be regulated and 
controlled fully automatically. To set a switch contact, you first need to select the switch point in the layout plan 
by clicking on the track immediately in front of the switch lantern, marked by a triangular direction arrow. Then 
select the switch contact from the list in the signal editor and click on the button to place the contact on the selected
track.

Attention: 
The correct selection of the switch point is particularly important if a switch branch is also the drive for 
a follow-up switch, as might be the case in track harps or at stations. 

The settings in the switch contact dialogue window are much the same as for signals. The only difference is the setting
in the Effect box. This determines when and where the switch is triggered – with the settings

• Main (straight)
• Branch (turnout)
• Next branch (alternative turnout)

The Next branch setting comes into consideration for three-way switches; the option Next causes the switch to
change to a different position each time the contact is passed.

Schema der Blockstreckensicherung
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A list with all the contacts assigned to a switch provides
you with quick access and direct editing. You will find
this list in the Properties dialogue windows, which can
be opened by right-clicking on the corresponding
switch point in the 2D track editor or the 3D editor for
routes. If one or more contacts are assigned to a switch
point, they will be shown in the list. After selecting a
contact, click on the Setting button to start editing 
the contact.

6.2.3 Sound contacts

With sounds contacts, you can assign charac-
teristic sounds in the form of *.wav files to 
vehicles and structures, such as locomotive horns,
the ringing bell of a tram, the wailing sirens
of fire alarms or loudspeaker announcements 

on platforms. This allows upcoming events to be
heard before they appear – provided, of course,
your speakers are turned on!

To insert a sound contact for a train horn or
 whistle into a track, first select the section 
where you would like to place the contact. 
Then select the sound type contact from the
list in the signal editor and click on the 
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button to place the contact. Now, when a train passes the contact, the *.wav file of the selected sound plays 
automatically.

The file can be selected in the contact dialogue box, where you can also make other settings. Clicking on the Add 
sound option will open the folder of available sounds which can be selected at will and played back at an adjustable
volume. Other *.wav files stored on your hard disk can also be used.

6.2.4 Vehicle contacts

The automatic control of vehicles via contacts is a 
crucial feature for all EEP users, and perhaps the most
important for model railway construction on a PC. 
Vehicles play a key role in the automation of an EEP 
layout as it is these that trigger actions by driving
over the connected contacts. Just as vehicles set au-
tomated processes in motion, they themselves can
also be set in motion by pre-defined automatisms.
This is implemented – like signals, switches, struc-
tures, sounds and cameras – by contacts assigned to
the respective vehicles in order to automate certain
processes. To place a vehicle contact on a route, switch
to the signal editor as usual, select the location on
the layout plan where you would like to place the 
contact, select the Vehicle type from the contact lists
and click on the button (see right) to place and con-
figure the contact.

In the contacts dialogue for vehicles, first define the
general settings that apply to all contacts. These 
relate to triggering when a train passes, to vehicles
and to the route. Once the general settings have been
made, you can set the special options that are relevant
for the automatic control of vehicles:

• the coupler control for train compositions

• the controls for loading/unloading vehicles

• speed memorise/recall

• the control of movable axes
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Furthermore, you can define a logical condition that must be fulfilled so that the contact actually switches.

A direct logical connection can also be created to 
another signal or switch via the signals dialogue
 window – simply and directly, without the aid of con-
tacts. In this way, logical connections to an 'if' condition
can be created, as is the case for switches and signals,
but without contacts. This reduces the number of con-
tacts required and simplifies the set-up. The direct
switch connection between signals allows, for example,
the two barriers of a level crossing to be linked. This
halves the number of contacts required for auto-
matic control.

To create a direct logical connection to a signal, right-
click on the respective signal to open the object dialogue window, and enter the ID number (without the leading 
zeros) of the other switch/signal that you want to “slave” to this signal. Then select the signal aspect in the menu on the
left that defines the 'if' condition requirement. Then select the appropriate setting for the “slaved” signal on the right. 
Repeat this for all possible aspects of the master signal.
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The coupler control – which has already been covered in the previous chapter – also applies to train consists so 
that entire train sets can be coupled and uncoupled. In this way, typical railway operations such as 'portion working' and
'running around' can be controlled automatically.

'Portion working' refers to the scheduled splitting of a train into two or more partial trains, one of which continues 
or ends on a different route. Railway workers use the phrase 'running around' to describe a train's change of 
direction of travel at a terminal station where the train's locomotive (or another one) is attached to the other end 
of the train before travelling back along the same stretch of track.

The coupler control option decides how many units should be uncoupled at the front or back when passing over a
vehicle contact. What's more, you can also give the separated section a new train name so that it can be integrated into
existing routes and timetables. With the Release coupler – Front coupler / Rear coupler option, the front or rear
section of the train is given a new name.

The new name corresponds to the name specified in the contact or, if a name isn't specified here, the old name followed
by a sequential number, counting upwards if one already exists.

In the speed control section, you may either define a
maximum or minimum speed or set a fixed speed for
the passing train. If you select the Reverse direction
option, the train will continue its journey in the oppo-
site direction when it passes over the contact. An 
elegant solution for shunting and turning. Please note
that, in the case of a train's reversal of direction, the
contact must only be triggered in one direction and
not both! 

Controlling vehicles also includes Load/unload 
controls when transporting freight and the control
of movable axes. These control mechanisms, which
you have been familiarised with through the examples
of  various functional models, can also be auto-
mated using contacts. There are a few further options
for the control of vehicles using contacts. Initially a train
passing a vehicle contact affects its own speed. But 
you may define another train to be affected instead,
thereby remote controlling one train when another
triggers the contact. This type of contact control is
 especially recommended for larger loading and un-
loading scenes where an often very high number of
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contacts can be distributed across a long
stretch, which improves both the
overview and the differentiation of con-
trol pulses. Equally, any other action sup-
ported by the targeted train can be con-
trolled remotely in this fashion. At least
two vehicles are involved in remote con-
trol (one to trigger the action, and one to
react to it). For this reason, the Apply to
vehicle/train option has been added to
the vehicle contact dialogue window
where the target vehicle or the train
composition can be specified.

Furthermore, contact control for
vehicles has been expanded with the
new option to switch signal lights on
and off in the contacts dialogue. If a 
tick is placed in the box, the respective
signal light (left, right or both) is
switched on, and if unticked, it is
switched off. A cross in the place of a tick
means that EEP takes control of the
 signal light. Depending on the construc-
tion of the respective model, the 'Pro -
duce dust' option activates a cloud of
dust (e.g. behind the wheels) like that
which you would see on dirt roads.

6.2.5 Copying contacts in 3D

It is possible to copy contacts in the 3D editor to speed up the construction and editing of recurring control 
sequences. The actual copying process is performed as follows: first left-click on the contact you would like to 
copy to select it (it will start to flash) and then right-click it to open the edit menu. Now select the Copy contact 
option.
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The mouse pointer will now be ac-
companied by the characteristic
'Set contact' icon and clicking on
a suitable place will set a copy of
the contact along with all of its
properties on the route.

6.2.6 Virtual depot 

To facilitate the construction of virtual
depots, two new contacts have been
added to the signal editor. You can use
them to make trains appear at a cer-
tain time or on a fixed cycle anywhere
in your layout. Of course, you can also
send these trains back to your virtual
depot from any other position.

6.3 Routes and timetables
Automatic rail operations where a fixed schedule is desired are controlled by a timetable. Using routes you can ensure,
for example, that:

•  regional trains stop at a station, while the ICE (InterCity Express) continues its journey without stopping,
•  regional and long-distance trains take different routes,
•  freight trains can bypass stations,
•  trams and busses don't drive on the same roads,
•  buses turn off into and stop in lay-bys, while cars and other vehicles continue driving.

Kopieren eines Kontakt-
punktes im 3D-Editor über
das Menü der rechten
Maustaste



149

To automatically set up these and similar traffic rules, the sequences need to be pre-programmed. This requires routes to
be defined. If certain pre-programmed sequences should also start regularly at specific EEP times, timetables also need
to be created.

6.3.1. Defining routes
To run rolling stock in accordance with a fixed timetable, you first need to set the routes.

Please be advised: 
Routes are simply filtering arguments for contacts. You build a list of route names and then assign the appropriate 
routes to your trains and vehicles. In consequence, you can then guide your traffic according to those routes by setting up
contacts which only respond to vehicles which have a specific route assigned to them.

There is a separate menu for the definition of routes in the menu bar, which can be opened in both 2D and 3D views:

• Select the Route edit option in the
Routes menu and then the option New
route in the following dialogue win-
dow.

• Enter your route's name in the Name route box and click on Add.

This will add your entry to the list of routes and delete it from the input box so you can define other routes and add 
them to the list in the same manner. Once all routes have been entered, you can close the dialogue box with OK. 
To change or remove an entry, select the route in the list. The Add option will automatically become Edit. In this mode,
you can change and remove existing entries.

Once you have defined
routes, set up the rele-
vant switches, inserted
vehicles and assigned
routes to these vehicles, 
you can now start the
automatic traffic opera-
tions.
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6.3.2 Generating timetables

As has already been mentioned, setting up timetables is only necessary if you want to start automatic sequences at a
specific time. 

Important: 
Only once you have defined routes, inserted vehicles and assigned routes to these vehicles can you 
create a timetable.

To create a timetable, proceed as follows:

• Click on the Timetable option in the Routes menu.
• In the following dialogue window, select the vehicle you would like to create a timetable for and click on the Add 

button. An input box with the text 'New timetable #1' will appear.
• Overwrite this text with an identifiable name.

Once the timetable has been created, you next need to select the time and route, and then define the signal and 
effect. This will assign the desired control effect to the selected route at the specified time. Specifically, proceed as 
follows:

• First, specify the signal – in our example, the signal with the ID 0010 – and select the effect Clear.
• Specify the time at which the signal should be set to Clear – here, EEP time 08:01:01.
• Select and activate the route. This means that the contacts placed on the stretch will only react to vehicles that are

assigned to this route.
• Finally, click on Add in the bottom-right of the dialogue window. This will apply the first timetable entry. 

In this way, you can compile the entire timetable – entry by entry – for automated traffic on your layout.

As timetables usually consist
of recurring actions, differing
only by the time at which the
action takes place, there is a
copy function. This allows you
to create complex timetables
without having to enter re-
curring actions again and
again. 
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When inserting a copied timetable action, an additional timeframe of 10 seconds is automatically added to it so that 
the copy can be differentiated from the original timetable action. The copied timetable entries can be individually
adapted in terms of the trigger time, route, signal ID and the desired effect. The copied entries can be used in multiple
timetables in the layout.

EEP's own timetable has received
some functional enhancements
since EEP 12 Expert. Whereas it was
previously only possible to control
signals via a timetable, switches can
now also be set. Existing timetables
can be saved to a file and, of course,
used in other layouts so that you
don't have to create a completely
new timetable for each layout.

6.4 Pre-set routes

The pre-set route feature allows you to activate routes in just two clicks. All the switches and signals belonging to 
the pre-set route are put in their correct places so that the route can be travelled. When activated, pre-set routes 
are automatically checked for potential conflicts and rejected in the event of a conflict. The beginning and end of 
a pre-set route are marked by a start and finish signal. The 3D pendants of these special signals can be hidden under
'View 3D window' in the 'View' menu.

2D und 3D
Ansicht des
Startsignal  

2D und 3D
Ansicht des

Zielsignal
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Before you get to the actual construction of this function, please note the following basic information. Pre-set routes 
are available to automate sequences relating to traffic operations in EEP.

An internal check is carried out to find out if, for example, another active pre-set route has control over the same 
track in part or whole. If this is the case, you will be unable to activate the new pre-set route conflicting with it. It is 
also checked whether other rolling stock is located within the pre-set route being activated. Only if the entire 
stretch is free can your wish to activate the pre-set route be fulfilled. 

You will also receive audible feedback. Now proceed as follows: First, switch to the Control tracks editor. 

On the right, you will find two icons used for building pre-set
routes. The top icon is the start signal, and the bottom one is
the finish signal. Now place a start and a finish signal in your
layout.

ATTENTION
Ensure that both signals are positioned to the right of the track in the direction of travel. 
If this is not the case, you won't be able to create a pre-set route. 

If a start or finish signal is standing on the wrong side of the track, move the mouse pointer to the edge of the signal. 
It will turn into a circle. Click this position exactly and the signal will jump to the opposite side. Click on the star of the
start signal – it is marked by a frame – and then click on the flag of the finish signal to connect them to form a pre-set
route. Switches located between the start and end first need to be brought into positions that establish a continuous
connection from start to finish.

In the first example, a very simple pre-set route has been built. Now we come to another example, which is some-
what more complex in structure. The entire scope of this tool will be presented. Now we will build pre-set routes 
from a single start signal to multiple finish signals. As you will see, even this isn't at all difficult. In this example, we will
also cover the signals that you can insert into your pre-set route. As you can see from the picture, all the semaphore
signals as well as the start and finish signals have been placed. I will also discuss the display in the overview window,
which you can use to control your placed pre-set routes.
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Depiction of the scene in the overview window

Now we select in the following order: the first pre-set route should be set from the start signal to the finish signal, 
which can be seen at the very bottom of the picture. After that, select the signal positioned directly above it, and so on.
First ensure that you are in 2D mode. Now position the switches that lead to the target track. In this example, the
semaphore signal on the left of the picture should also be set to 'Clear'. All other semaphore signals should show
'Danger'. Set them accordingly. Once you have made these settings, click on the pre-set route's start and finish signal
one after the other. 

Now select your pre-set route, if it isn't selected already. Hold down the [Ctrl] key and click on the signal you would 
like to add to this pre-set route.  Do the same for any additional signals you would like to add. In this way, you can 
add as many signals or switches to your pre-set route as you like. Do exactly the same for the next pre-set route. 
Set the switches and signals and repeat the process.

Control during rail operations:
You can take control during ongoing rail operations either directly in the 3D area or in the overview window. Click on 
the start signal and then on the finish signal while holding down the [Shift] key. If everything is in order, your pre-set
route will be activated. If the pre-set route is occupied, because either another pre-set route has been activated or rolling
stock is occupying the pre-set route, you will receive a message in the 3D window. 
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Activation via contacts:
Of course, your pre-set routes can also be activated via contacts. To achieve this, set a contact for the pre-set route's 
start signal. You can now enter which pre-set route should be triggered in the Effect box. You can also remove the  pre-
set route at this point.

Tip:
You should take a look at the videos we have made available regarding the working of pre-set routes:
www.eep11.com/tutorials 

6.5 Lua

The integration of the Lua scripting language is a milestone in the development of EEP. Lua and its features provide 
you with very powerful tools to wire up your layouts in a very clear manner. Lua can save you additional control tracks.
You will find comprehensive instructions on this topic under the Lua manual option in the Help menu. In this docu-
ment, the Lua language is explained to you in a basic way using the tutorial layouts provided. Integrated wizards help
newcomers to build simple scripts.

6.5.1 Lua wizard

General information
With the Lua wizard, we have created a simpli-
fied way for you to make Lua scripts. Using this
additional programme is very simple. Further
wizards will be released at a later date, and will
be available via the TREND shop.

The user interface of the wizard is available in
the EEP 13 bar after launch. Please note that
the wizard is only available if it has been started
by clicking the Wizard option in the Extras
menu. 

Once you have launched the wizard, a menu will
guide you through the task. Simply follow the
specified steps to reach your objective. Once 
you have completed all the steps, a window 
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will appear where you will see your new, complete script. Press the button to copy the new script to the clipboard. Now
all you have to do is replace the old script with the new one. To do so, proceed as follows:

– Open the script window in EEP 13
– Right-click on the script
– Now choose the Select all option
– Right-click in the script window again
– Now select the Insert option
– Click on the 'Reload script' button
– Close the EEP Lua Script Editor

Wizards in EEP 13
There are various wizards available to you in the basic version of EEP 13: the timetable wizard, a wizard for controlling
level crossings, wizards for the vehicle and structure control features, and one for 'track occupied' queries.
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Timetable wizard
You can create your own timetable with this wizard. You can make changes or additions to this timetable at any time.
Simply open the wizard again if you would like to make changes or additions.

Create level crossing 
This wizard gives you a multi-track level crossing that doesn't use any control tracks. The script is invoked in a vehicle 
contact and you simply enter the corresponding function in the Lua function field of the contact.

Tip: 
You will also find comprehensive tutorial videos on Lua and the wizards at www.eep12.com/tutorials
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7. The EEP Control Panel Editor 

This feature of EEP allows you to create a control panel for your layout and to completely control your layout via this
control panel, just like a signal box in its real-life equivalent.

New features to EEP 13 include diagonally arranged buffer stops in the track section, and 'camera buttons' in the
Other section which you can use to switch to any saved camera position on your layout.

First, however, we would like to give you an overview of the structure and functions of the Control Panel Editor.

7.1 The main window
First, we'll introduce the main window of the Control Panel Editor and the elements it contains. This main window is di-
vided into three sections:
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1. The workspace
The workspace is the actual work centre of the Control Panel Editor. When the programme is started, this area is auto -
matically made up of ten columns and five rows. If this size is not sufficient, you can add further columns using the
'Add table column' function. The same goes for rows.

2. The Selection window
The Selection window has the four following options: the 'Tracks', 'Switches' and 'Signals' selection windows, and the
'Other' selection window, which is new to EEP 13.

These four options are used to display the different Control Panel Editor model types clearly and to make them available
for later insertion.

3. The Information window
The Information window helps you to keep track of your project. This Information window has three different modes,
which we would first like to describe briefly before we explain them to you in two separate sections. 

Mode 1: Build track layout
This mode is opened when the programme is started, meaning
you are always in the mode for setting up your control panel. 
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Mode 2: Copy and insert
If you have ready-built elements, you can copy these elements in
your control panel and insert them elsewhere. Furthermore, it is also
possible to cut elements from the existing control panel and to insert
them again elsewhere.

The following icons are available in 'Copy and insert' mode. Alter -
natively, you can also use the right mouse button of the 'Edit' menu.

Explanation of the elements from left to right:

Copy the selected elements

Cut the selected elements

Insert copied or cut elements

Delete the selected elements

You can select several elements at once. To do so, proceed as follows: you can only copy rectangular sections of the desk
layout. Select an element to mark one corner, then hold down [Shift] and select the element in the opposite corner. The
selected square segment is highlighted. Press the 'Copy' button to transfer it to the clipboard. Select the top-left corner
of the target area. Press 'Insert' to insert the copied section here.

Mode 3:  Assign track layout
In this mode, the individual elements of the track layout you have cre-
ated are assigned to your EEP layout. 

7.2 Build track layout

This mode is the first major step in creating your control panel. Here you can build and, of course, overwrite exactly as
you like. Very important: This is where you create an image of your layout. The mapping to the actual layout is done 

later and in another mode. Place icons, add rows and columns as required and delete them when you find that you 
have too many. It is advisable to begin small. You can always extend your panel when necessary. 
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You can deploy multiple control panels in EEP 13, so your
 entire layout doesn't have to be represented in a single con-
trol panel.

1. Lay track or switch

If you would like to lay a track
or a switch, select the corre-
sponding element from the
selection window and place it
on the appropriate tile. 

2. Place signal
If you would like to place a signal, however, you should proceed slightly different: first, select the corresponding 
element in the selection window shown. In the first row, you will find two different elements that represent all types 
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of signals. The only difference is in the arrangement in the control panel. 
The left element stands for a signal that is displayed in the top half of the
tile, and the right symbol is shown in the bottom half.

In the second row, you'll find the two symbols for pre-set route’s start 
symbols. Once again, one for the top and one for the bottom position.

In the third row, you'll find pre-set route’s finish symbols.

Select the correct position in the information window, as already de-
scribed, and then select the desired symbol in the selection window. 
Now click on the tile that you want to hold the signal button. If you realise
that a button’s position is inappropriate, you can delete it. First select 
the desired position (left, middle, right). If it contains a signal, you can

delete it. Otherwise, the button will re-
main greyed out.

3. Insert camera
If you would like to insert a camera, select the
camera from the 'Other' selection window. You
can then click on the tile where you would like 
to insert the camera. 

7.3 Assign track layout

This is the section where assignments can be made to the EEP
layout. It is the most exciting section, but it also demands the
greatest attention from you. However, you are now not far from
completing your control panel. 

This mode receives a green tick once it has been activated. In ad-
dition, the colour of a selected tile
in the workspace also changes.

This also turns green. 
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The selected element will also appear in the information window. In our example, only a track has
been laid, but no signals. You therefore see the following image.

An orange tick can be seen in front of the object. This shows that it has not yet been assigned. 
Now click on the image next to the tick.

Once you have done everything, a green tick will appear before
each element. Additionally, the colour in the workspace will also
change from pink to grey. This shows that all elements have been
assigned and that your control panel is complete.

The display in the workspace will then look like this:

If you have multiple elements on a tile in your workspace
(track, signals), you can assign them in one go. To do so, se-
lect the 'Assign all' option. Then left-click on the various
icons to assign them.

Selection window
Here you can see an overview of the window to assign the individual elements of the control panel to the EEP ele-
ments. As this is very important for the correct functioning of your control panel later on, here once again are the
elements in detail:
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In the detail view, you will see the individual elements that currently need to be assigned. Please pay close attention 
to the order of the diodes.

Important:
If you remove the tick for the switch ID, this specifies that this switch element can later only be viewed in
EEP’s control desk, but not operated. 

Once you have finished assigning elements, apply them by clicking this button.

If you have selected the wrong track or signal, clicking this button will reset everything
and the assignment will start again from the beginning.

Clicking this button closes the dialogue window without making any changes to the
selected element in the workspace.

In this box you see the list of all the track styles included in the layout. They can be hidden by removing the tick, which in
some cases makes things much clearer. If, for example, track objects or platform splines are listed here, you would surely
never want to assign them to a control panel.

Finally, in the workspace you'll see the track network of
the layout most recently loaded in EEP. 

There are two ways of enlarging the display. Either click the area you would like to enlarge whilst holding down the 
[Ctrl] key, or else use the Zoom in button. Zooming out works in a similar way. Click on a section of the display whilst
holding the [Ctrl] and [Shift] keys and it will zoom out. In both cases, it attempts to centre the display around the 
position of the mouse pointer at the time of the click. An element can be selected by clicking on it or by dragging a
 selection box around it whilst holding the left mouse button. During the assignment, saved camera positions are shown
as green and blue circles.

The layout shown here can be found in Tutorial 56 in EEP.
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8. Settings and support

8.1 Programme settings

The programme settings relate to the
functioning of the programme and the
quality of the display. The individual
options, which can be activated, deac-
tivated and/or adjusted, affect the ap-
pearance and so the overall experience
of the virtual railway world, but they
also make considerable demands on
the processing power of your computer.
If you would like to exploit the impres-
sive capabilities of computer graphics
to the very max, this may result in a dis-
proportionate processing effort and a
drop in performance. Therefore, it is im-
portant to balance and keep an eye on
both the on-screen display and the
general performance. Checking and ad-
justing the programme settings is
performed in the configuration menu
of the same name, which can be
opened via the File menu or via the
button with the tools in the top tool
bar.

The graphics settings take up most of the space in the programme setting menu. Many options have been added,
 especially in the graphics section.

Smoke quality
The more smoke particles are emitted, the more impressive the billow of smoke appears, but the higher the demand <<
on the processor.
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Track detail level
The further to the right you move the slider, the more detailed and accurately track curves are drawn, but this puts a
greater burden on your graphics card.

Sparks quality
A range of vehicles generate sparks – at the wheels, on the overhead lines or from the smokebox (of steam engines). This
can be adjusted gradually using a slider.

Display
The four basic components of colour effect and colour perception can be adjusted individually using the Hue, Satura-
tion, Brightness and Contrast sliders. Hue is the property responsible for distinguishing basic colours such as red, 
green, blue and yellow, while Saturation relates to the quality and intensity of the colour effect.

Good to know: 
The settings here determine the definitive appearance of the layout, regardless of your monitor's current
settings. If a slider is active, you can reset an altered setting at any time by pressing the [Home] key.

Anti-aliasing
This function, which is activated via the corresponding option for your graphic card and can be switched on in various
gradations in EEP, compensates for annoying 'jaggies' by blending the colours of adjacent pixels.

Graphics card filter
This option refers to texture filtering, which can either be deactivated or activated at selectable quality.

Rendering size
Rendering effort can be reduced by up to 50% through scaling.

Shadow quality
Shadows can either be deactivated or activated at low, medium or high quality.

Anaglyph 3D 
The 3D distortion can be set here, which requires red/cyan glasses. As the image needs to be rendered twice, this can have
a negative effect on performance.

Limit refresh rate to 30 fps
This recommended setting limits the image refresh rate to 30 frames per second, but guarantees smooth-moving 
images.
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Double visibility range
Activating this option allows the maximum visibility range in the 3D view to be doubled, which however may 
cause significant drops in the frame rate.

Bloom start / Bloom intensity
This lighting effect produces scattered light with blurred contours, like a glow or an aura. The intensity and the position
of the effect in relation to the depth of space can be set using sliders.

Sound settings (Volume)
You can set the volume for the playback of sounds using a slider. The following settings relate to the optimal functioning
of the programme and can be activated or deactivated as desired:

Auto save
If this option is enabled, your layouts will be automatically saved at a fixed time interval. For this purpose, a sub-
folder will be created in the Layouts folder where automatically saved layouts are stored. The number of saves depends
on the size of your hard disk. If you save larger layouts regularly, it is recommended that you deleted unrequired interim
saves to free up space on your hard disk.

Display frame rate
The frame rate is the number of images shown per second on the screen. If the 'Display frame rate' option is active, 
a counter will be displayed in the top-left corner of the 3D window showing the current number of frames per 
second that can be displayed. A relatively fluid image is produced at a rate of 17 to 25 frames per second. If the
number of frames falls below 17, the image – depending on the CPU and graphic card – seems fitful due to the jerky
movements.

Good to know: 
Juddering indicates that the number of models in the area of the layout is too high for the computer to
 calculate the optimum number of frames. You can avoid this by reducing the number of models being
 calculated. Delete any performance-heavy objects, avoid large collections of models in a small area, thin out
simulated forests, and you'll already have a much smoother picture!

Display time in 3D view
This displays the current EEP time in the top-right of the 3D window, which you can set in the Extras menu under the Time
Properties option.

Display train, speed and camera
Activating or deactivating this option shows or hides the camera name, the current speed and – new to EEP 13 – the
name of the active train.
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Scan models at every programme start
If this setting is activated, the models will be automatically scanned each time the programme is started. Basically, 
additional models purchased from our online shop or which have been downloaded for free need to be 'scanned' 
(registered) before use. Without scanning, they are installed in the model list but cannot be found in the corresponding
category.

Good to know:
You do not need to restart EEP every time after installing additional models! Directly after installation, you can
run the Scan models command from the File menu. Following the scan, the new models will be available in EEP.

Scan models at next programme start
Have you only just purchased and installed new models, but not run the 'Scan models' command? Then you can choose
this option so that EEP performs the scan automatically the next time it is launched.

Undock windows
You have the option of moving the control dialogue windows and the overview window freely on your screen, or to move
them to a second monitor, if available.

Turn lights on/off with daylight
If you place a tick in this box, the lights of any rolling stock equipped with lights will switch on automatically when night
falls in EEP, and switch off again when day breaks. This feature only works if you run your layout on EEP time.

No rendering below layout surface
If this option is active, objects located beneath the surface of the layout, and therefore invisible to the user, are not
 rendered. This setting reduces the processing burden and improves performance. However, please bear in mind that
tunnel walls are also located beneath the surface.

Vehicle anti-collision query
Activating this option significantly reduces the risk of collisions in queues of road vehicles.

Passing trains cause air disturbance
Activating this setting causes the camera view of the observer to be affected by air pressure waves of passing 
vehicles.

Dynamic motion of landscape elements
This setting completes the simulation of the air pressure wave so that air pressure waves of passing vehicles temporarily
deforms the geometry of landscape objects, giving the optical impression of a gust of wind.
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Invert camera X orientation
This option switches the camera's horizontal axis when using the mouse, keyboard or gamepad.

Invert camera Y orientation
This option switches the camera's vertical axis when using the mouse, keyboard or gamepad.

All categories editable in 3D editor
If this option is activated, all objects can be edited in the 3D editor – regardless of the category – allowing landscape 
objects, structures, routes and rolling stock to be edited at the same time. If this object is switched off, editing is 
restricted to the object type of the selected category.

Use real time of day in EEP
If this setting is activated, the EEP time of day will be matched to your computer's time setting when saving a layout. 
This allows time stages to be documented when building a layout and the respective lighting conditions can be
adapted automatically. Alternatively, you can set the EEP time in the Menu Extras -> Time settings.

Hide objects close to camera
This option can be used to make disruptive landscape objects – e.g. bushes and trees blocking your view of a passing
train – appear transparent. This does not affect the object itself, however, but only its appearance on camera.

Splashing water
If this option is activated, the wheels of travelling cars and other road vehicles will spray rainwater – provided 
the intensity of rainfall is set to at least 40%. Unlike dust clouds, which are triggered for road vehicles by contacts 
but are limited to certain segments of road, the rainwater function is set or disabled globally for the entire layout.

Videos
EEP allows you to make small videos of your layout. The settings for recording videos can also be found in the Programme
settings window.

AVI (fps)
A frame rate of 30 fps is recommended for the distribution of videos on internet platforms.

Length of AVI movie (sec)
The length of the movie in seconds should be set whilst taking into account the computer's processing power and
storage space.

Select AVI codec
Clicking on this button will open a small dialogue window in which you can select the compression programme. 
Generally, several codecs will be available – depending on which programmes are installed. You will achieve the best
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 possible output by selecting the Full frames (uncompressed) option. However, videos in this format require several
 gigabytes of hard disk space, depending on the length of the video. Uncompressed videos are advisable as the source
 material, especially if they are being written to CD or DVD. Once you have set the frame rate, the length and the
 compression, you can close the Programme settings dialogue window and start recording your video by pressing the -
keyboard shortcut [Ctrl] + [F12]. The finished film will be saved in your EEP installation folder.

ATTENTION
Recordings in tracking mode are interrupted following the first camera change for technical reasons.
 Screenshots can be taken in the 3D view by pressing the [F12] key, and they are stored in the EEP directory
in BMP format.

Good to know:
EEP 9 users may possible miss the option for the need of track electrification for electric locomotives. 
With EEP 10, the option has been moved from the program settings to the layout information. This 
option makes operations on your layout even more realistic. In order to set electric vehicles in motion, 
the tracks must be equipped with an overhead power line or an electrified track, and the pantographs must
be raised
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8.2. Hotkey table
Please ensure that you are always working in the corresponding window when using these keys, e.g. mouse pointer 
over the 3D view when switching camera angles.

Mouse navigation  

Scroll in the planning window or 3D view                       Roll scroll wheel at edge of screen

Zoom in the planning window or 3D view                       Roll scroll wheel in centre of screen

Category selection:  Source/Filter                                       Double-click

Select objects                                                                              Left-click (Note mode, tab bar, control dialogue)

Open dialogue boxes                                                               Right-click on selected object

Help

     Select menu option

           Send application to background

           Quit application / Exit EEP

Letter

General
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Scroll

Delete selected object

Switch to 3D view

Reduce scale

Increase scale

Full-screen mode

Switch to planning window

Control elements and planning window

Maximise window

Tracking shot in/out

Screenshot of 3D view

Create AVI films

Return to windowed view from full screen

Pan camera left/right

Pan camera up/down

Move camera left/right

Move camera forwards/backwards

Planfenster

3D window
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Leertaste or

or

or 0

Move camera forwards

Move camera backwards

Raise camera position

Lower camera position

Centre camera on origin

Camera control via contacts on/off

On-board camera view from left

On-board camera view from right

On-board camera view top-left

On-board camera view top-right

On-board camera view forward

On-board camera view backwards

Switch to tracking camera

Switch to cabin view

User-defined camera

Automatic mode: Increase target speed forwards

Automatic mode: Increase target speed backwards

Automatic mode: Target speed 0

Akustisches Signal

Kupplungshaken hinten

Kupplungszustand vorne

Zugbremse

Schaltzustand von Weichen

Schaltzustand von Signalen

Pause
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or

oder

Reduce focal length

Increase focal length

Reduce aperture

Increase aperture

In editor mode, object properties in
the test camera settings
(3D window)

Scroll left

Scroll right

Scroll up

Scroll down

als Hotkey zur Anwahl von 
Rollmaterial definieren

Scroll left

Scroll right

Scroll up

Scroll down

Insert most recently inserted cargo again

Reduce scale

Increase scale

Display the frame rate as a graph, hide graph

Increase scale of the graph

Decrease scale of the graph

Control dialogue

Overview window

Buch-
stabe
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Technical support

EEP has been subjected to many different, extensive tests on many different hardware configurations, so generally 
no problems should occur. However, it is not possible to test all configurations. Before calling our technical support team,
please have the following details about your hardware ready:

• Which operating system are you using?
• What kind of processor do you have and how much main memory (RAM) is your computer 

equipped with?
• Which version of DirectX is installed on your computer?
• What kind of graphics and sound cards are installed in your computer?
• What version drivers are you using for your graphics and sound cards?

If you do not have the above information available, the DirectX 9.x diagnosis programme could be helpful. Click on Start
– Run and enter the command line 'DXDIAG'. The diagnosis programme will provide exact details about your computer
under the System menu option. If you write us an email, please include the DxDiag.txt file as a packed attachment. 
To obtain this file, open the DirectX diagnosis programme and click on the Save All Information button. 

Please also check the following webpages for specific information that might help you to solve the issue yourself.

FAQ section:           hilfe.eepshopping.de                                   EEP-Shop:                         www.eep.eu
                                                                                                                   Product homepage:     www.eep13.com

If you cannot find a solution, please contact our support team.
By phone: EEP application support (Monday to Friday, 10 am to 6 pm):

Telephone +49 (0)900 1229999 (€0.99 per minute from a German landline)

Online community
Mein EEP-Forum (MEF): www.eepforum.de
Here you will find a specialist forum where questions are answered and many problems are solved. Here you can discuss
with other EEP users and be part of the interesting EEP world. The latest news and information about the programme
are published here first hand.

EEP on Facebook:  www.facebook.com/EEP.Eisenbahnsimulation
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